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Welcome to CoPilot Truck | Laptop 9!
CoPilot Truck | Laptop 9 is ALK Technologies’ latest version of our CoPilot® software that 
provides GPS in-vehicle navigation and route guidance from your laptop PC.  CoPilot Truck | 
Laptop 9 transforms your laptop or Tablet PC into an advanced GPS nav system.  You'll receive 
spoken, turn-by-turn directions to any address. With a brilliant 3D map display to guide you and 
the ability to detour around sudden traffic, you’ll never want to be on the road again without 
your CoPilot! 

System Requirements
--  Microsoft® Windows® 2000, ME, or XP.
--  400 MHz Pentium® II processor or equivalent.
--  16X CD-ROM (12X recommended if using Data Disc 

as data source).
--  128 MB of RAM and a hard drive with at least 250 

MB of available disk space.  For best performance of 
“talking maps” and GPS track files, we recommend 
256 MB RAM.

--  A Serial, USB, Compact Flash or Bluetooth connection 
(depending on receiver type).

--  CoPilot's voice recognition requires a microphone and a low-noise environment.  For 
best results, an external microphone is recommended (plug in before starting CoPilot).

--  Minimum 800 x 600 resolution.
-- If you are using a third-party GPS receiver rather than ALK's CoPilot receiver, it must 

be NMEA 0183 v.2.0 protocol.

Package Contents
--  Install / Data Discs
--  Printed Quick Start Guide
--  GPS receiver and suction cup for securing receiver to windshield 

(not in software-only packages)
-- In-vehicle power adapter (only in Bluetooth receiver packages)
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How Reliable is CoPilot?
The CoPilot map database is remarkably accurate, providing comprehensive, detailed street 
information.  From the most populated cities to the smallest hamlets, CoPilot map data has been 
created to support your travels wherever they may take you.  

Data Corrections
ALK continually updates the CoPilot map database as we strive to provide you with the 
highest quality product.  If you encounter missing or inaccurate map data, please contact us 
and let us know so that we can include it in our updates.  See Data Corrections p. 69 for 
complete instructions.

About GPS Technology
The Global Positioning System (GPS) is a tracking and navigation system developed by the 
U.S. Department of Defense.  The system uses 24 satellites that orbit the earth, sending out 
radio waves that can be picked up by GPS sensors (hardware devices for receiving data).  
Normally, a GPS sensor relies on receiving signals from four satellites simultaneously to 
track its position.  Each signal contains an identifier for the satellite that emitted it and the 
exact time it was emitted (to the nanosecond).  GPS relies on the fact that radio waves travel 
at the speed of light to calculate distances and the exact location of the sensor is figured by 
combining the data received from three or four satellites.

Given the right conditions, a GPS sensor can identify your geographic position anywhere 
in the world.  GPS is able to give you the latitude, longitude and elevation of your present 
location, as well as your road speed and direction of travel on a route.  

GPS Accuracy
The GPS signal CoPilot receives from the constellation of satellites has a rated accuracy of 
10 meters.  This means that 95% of the time the reported location is within 10 meters (30 
feet) of your exact position.  CoPilot takes this location information and enhances it further 
by "snapping" it to our street and highway network.  Occasionally, CoPilot will place you on 
the wrong road.  If this occurs, keep driving and CoPilot will automatically correct itself and 
find your proper position.

At times, CoPilot's GPS tracking will be less accurate or fail to work at all because the unit 
is unable to receive satellite signals.  However, the unit is resilient; eventually, it finds itself.  
Its ability to report your location is directly proportional to its ability to receive accurate 
line-of-sight satellite signals.  Heavy foliage, buildings, tunnels, or any other structures 
obstructing satellite communications will interfere with CoPilot's ability to track your 
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location.  Like your car radio, GPS tracking can also be affected by weather conditions if 
severe.  CoPilot will continue tracking as soon as adequate signals are available.  

NOTE: The GPS unit should be placed far forward on the dashboard to maximize the 
satellite reception area.

How CoPilot Uses GPS
CoPilot uses the GPS positional data it receives from the GPS receiver to display your 
current position and route on a map as you drive.  This is called “tracking.”  CoPilot also 
uses the GPS data it receives to “navigate,” that is, to guide you along your planned route, 
provided you enter a destination.  

If you enter a destination you will be given navigation instructions, and your route will 
be tracked on the map.  If you do not enter a destination, your route will be tracked as 
you drive, but you will not be given directions as CoPilot has no way of knowing your 
destination.

A Safety Warning 

Do not use this product in any way that interferes with safe and attentive operation of a 
vehicle.  When used in a vehicle, do not place the GPS receiver, antenna, power supply, or 
your computer where it may strike the driver or passengers if the vehicle turns sharply or 
stops abruptly.  This product is designed, manufactured, and intended as an aid to planning, 
tracking, and following routes in privately owned vehicles.  

The accuracy of the map data, driving directions, and GPS tracking system is insufficient 
for this product to be used for automated navigation or in any situation in which the failure 
of the product could lead directly to death, personal injury, or physical or environmental 
damage.  The driver must remain alert at all times to actual road conditions and obey 
all posted signs and traffic regulations.  ALK Technologies and its suppliers specifically 
disclaim any express or implied warranty of fitness of this product for automated navigation 
or for aiding in the operation of other than a privately owned vehicle.
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WARNING:
CoPilot navigation instructions are only computer-generated advisories and may 
contain errors.  Obey all traffic regulations even if they are completely contradictory 
to the navigation suggestions.  Keep your eyes on the road and hands on the 
wheel!  Do not attempt to look at the screen if you are the driver.  ALK® assumes no 
responsibility for any damage or injury resulting from the use of this product. 
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Installation
NOTE: If you are updating from an older version of CoPilot®, you may want to uninstall 
the older version first (see Uninstalling, p. 8).  This is not required, however.  CoPilot Truck 
| Laptop 9 can be installed while another version of CoPilot remains on your computer. 

1.  To install CoPilot, first turn on your computer (and the external CD-ROM drive if 
necessary).  Have your Installation Product Key ready (this code can be found on the 
front of the printed Quick Start that came with your product). Do not lose this Product 
Key, you will need it for installation and registration.

5.  Follow the instructions, clicking Next to go from one screen to the next in the 
Installation Wizard. As the installation proceeds, you will be given the choice to install 
CoPilot map data. It is recommended that you install the Map Data to your hard 
drive.  A full installation of the data can require up to 1 GB1 GB of available space depending 
on which region you’re installing.  If space is unavailable, you can run the program by 
inserting the Data Disc into your CD-ROM drive after you open the CoPilot application.  
NOTE: Once a region (for example, North America or Europe) is installed it cannot be 
changed.   

4.  After clicking Yes (twice) to accept the 
License Agreement, enter your Installation 
Product Key (see Step 1) when prompted, 
then click Next.

2.  Insert the CoPilot Install Disc into your 
CD-ROM drive.  The installation will start 
automatically within a few seconds.

3.  Choose a language (for example, "English 
(United States)"), click OK, then follow the 
Installation Wizard instructions.



5.  At the end of the installation process you will be prompted to activate the software.  
CoPilot must be activated within 15 days after installation in order for you to continue 
using it.  Follow the instructions.  Follow the instructions in the Software Activation 
section below.

6.  Plug the GPS receiver into your laptop.  See Hardware Setup, p. 9-11.  
NOTE: The receiver must be attached before you can use CoPilot for guidance.

7.  Make sure the date and time are set correctly on your computer.  This is extremely 
important for CoPilot Truck to function properly.  To check and/or change the date and 
time, go to the Windows Start button, Settings, Control Panel, Date/Time.

To start CoPilot, double-click on the CoPilot Truck | Laptop 9 icon that was created on 
your laptop when you installed the program.  To quit at any time, select Exit from the File 
menu in Planning Mode, or Exit in the Guidance Mode navigation control panel.  

NOTE for XP Users:  If you are installing CoPilot on a computer running Windows XP, 
you may be prompted to connect your GPS receiver during installation.  If you are using the 
USB GPS receiver, Windows XP will pop up a message warning you about Windows Logo 
testing.  Click Continue Anyway if this warning appears.

Software Activation
At the end of CoPilot’s installation process, you will be prompted to activate the software.  
CoPilot must be activated before you can use it.  NOTE: You can install and activate 
CoPilot on your desktop computer (for trip planning) and your laptop (for in-vehicle 
guidance) using the same Installation Product Key.

Follow the steps below to activate your software:
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1.  At the end of the software installation, 
the License Activation Wizard will 
appear.  If you cancel this screen, it 
will appear again the first time you 
open CoPilot.  For automatic activation, 
follow the on-screen instructions and 
click Next.



To Activate Manually:
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2.  In the next screen, enter your e-mail address 
and click Next.  CoPilot will be activated within 
seconds provided you established a connection to 
the internet in Step 1.  You will see the message 
“License activated successfully” when the 
process is finished. Click Finish to begin using 
CoPilot.

1.  Check Activate Manually in Step 1 above, then click Next.  

2. The next screen is the Activation Code screen, where you’ll see your Product 
Key and License ID.  You’ll need this information to manually activate CoPilot 
as follows:

a)  If your laptop is connected to the internet you can click the link to ALK’s activation 
web page.

i) On the ALK activation page, enter your Installation Product Key, License ID, 
and e-mail address, then click Submit.  Your Activation Code will appear on-
screen and an e-mail that contains your Activation Code will be sent to you.

ii) Enter your Activation Code in the blank field in the Activation Code 
screen and click Activate.

b)  If your laptop isn’t connected to the internet you can visit ALK’s activation web 
page (http://activate.alk.com) on another personal computer.  Follow steps i) and ii) 
above.

c)  If you do not have internet access you can call, fax, or e-mail ALK.  Technical 
support is available to registered users from 9:00am-5:00pm Mon.-Fri.   

For ALK Technologies contact information, see Technical Support, p. 70.  



- 7 -

Adding a Data Region
If you have purchased an additional data region after your initial purchase of CoPilot, you 
will need to modify the original (“Base”) installation and activate the new region.

IMPORTANT:  You can only use your Expansion Product Key AFTER you have installed 
CoPilot with a Base Installation Product Key.  If you have not yet installed CoPilot, please 
do so first and then follow the instructions below.  The Base Installation Product Key can be 
found on the printed Quick Start Guide that comes with CoPilot.

1. Insert your CoPilot Install Disc into your CD-
ROM drive.

2. Select Modify and click Next when the 
InstallShield Wizard appears.

3. Enter your Expansion Product Key when 
prompted to enter a Product Key.

4. Follow the on-screen instructions.

5. The Activation Wizard will appear at the end of 
installation.  Activation occurs just as it did when 
you originally installed CoPilot.
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Uninstalling
The following steps outline the procedure for uninstalling CoPilot® 2003 and older versions 
of CoPilot: 

To uninstall the CoPilot software:
1. Exit out of any programs that are running.
2. On your desktop, double-click on My Computer.
3. Double-click on Control Panel.
4. Double-click on Add/Remove Programs.
5. Scroll down the list of applications until you see CoPilot [Version].  Click on it to 

highlight it, then click on the Add/Remove button.  You will then be asked “Are 
you sure you want to completely remove the selected application and all of its 
components?”  Click Yes.  This will start the uninstall process.  If prompted to 
remove all shared files select No to All.

6. When this is finished, click on Finish.  Then restart your computer.

Deactivation and License Update:
If you’re planning to uninstall CoPilot from one computer and install the same version on 
another computer, you need to deactivate the software on the first computer before installing 
it again.  To do this, open CoPilot and choose Update License from the File menu.  Then 
click Deactivate in the License Manager.  When you re-install CoPilot on another computer, 
you will be asked to activate it again.
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To Uninstall Data From Previous Versions of CoPilot:
NOTE:  Data is automatically removed as part of the CoPilot 2002 or later uninstall.  

For earlier versions of CoPilot, this process is not required but you may want to do 
this if you have uninstalled the application.

1. Exit out of any other programs that are running.
2. On your desktop, double-click on My Computer.
3. Double-click on Control Panel.
4. Double-click on Add/Remove Programs.
5. Scroll down the list of applications until you see CoPilot 2001 Data CD or Data  

CD setup for CoPilot 2000.  Click on it to highlight it, then click on the   
Add/Remove button.  You will then be asked “Are you sure you want to   
completely remove the selected application and all of its components?”  Click  
Yes.  This will start the uninstall process.  If prompted to remove all shared files  
select No to All.

6. When this is finished, click on Finish.  Then restart your computer.

Hardware Setup
WARNING:  Never leave your GPS receiver in a closed vehicle that exceeds 140o F.    

Excessive heat may damage it.

See page 22 to set up a USB receiver.  See p. 11 to set up a Serial receiver.  (Although 
these instructions are specific to CoPilot receivers, connecting third-party receivers should 
be very similar.)  For Bluetooth receiver setup see p. 10, or for more details refer to the 
GPS Receiver Guide that came with your product.

The GPS unit should be placed far forward on the dashboard of your vehicle to maximize 
the satellite reception area.  The GPS receiver works like a radio antenna, so place it at least 
two feet away from possible sources of interference (for instance, a cellular phone antenna).

The first time you use your GPS receiver it can take up to 15 minutes to acquire a satellite 
fix.  After you use it once, the receiver should initialize within a few minutes.  



Bluetooth Receiver Setup
1. Pair your Bluetooth GPS receiver with your PC’s Bluetooth software.  It is important 
that you connect the Bluetooth GPS receiver to a virtual serial port (also known as a “COM 
port”).  See your Bluetooth software’s user manual for specific instructions.  
If you are prompted for a security code to pair your Bluetooth GPS, use 0183.

2. Open CoPilot and find the GPS signal. 

a. Option 1:  Select Find GPS to automatically scan through your PC’s COM ports until it 
finds the Bluetooth GPS connection.

b. Option 2 (Advanced):  If you know the number of the virtual serial port to which the 
Bluetooth GPS is connected, go to Guidance Mode and select Options.  Then select GPS 
Status and set the GPS COM Port (ex: “COM 10”).

USB Connection
If you are using a USB connection you will have one wire which attaches the GPS receiver 
to the laptop through its USB port.  Plug the receiver into the laptop after Windows is 
finished booting up.

Windows XP Users:  When you first connect your USB receiver, you might see a Windows 
message indicating that the drivers have not passed Windows Logo testing (or a similar 
warning).   Ignore this message and click Continue Anyway if it appears.
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USB Port Connector
Plug into USB port [A1] on 
your portable computer

USB Port [A1]

NOTE: Your laptop's ports maybe in a different arrangment

GPS
Receiver
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Serial Connection
When connecting to a laptop through a serial port the receiver is powered through the 
laptop’s battery.  Plug the PS/2 port connector on your GPS unit into the PS/2 port of your 
laptop.  Do not plug the serial port connector into your laptop until after Windows has 
finished booting up.  

TIP: To see the serial ports available on your PC, open the Control Panel, select System, 
click on the Device Manager tab, then click on the plus sign next to Ports in the list of 
devices.  The Settings box displays the hardware settings used by the COM port.  The 
setting for your COM port should be 4800,8,N,1.  See diagram below for connection 
instructions.

Serial Port [A]

NOTE: Your laptop's ports maybe in a different arrangment

GPS
Receiver

Serial Port Connector
Plug into serial port [A] on 
back of portable computer

PS/2 Port [B]

Cable 1
Goes to GPS receiver

PS/2 Connector
Plug into PS/2 port
[B] on back of 
portable computer

Cable 2
Ends at PS/2 
connector
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CoPilot Truck can be used for in-vehicle navigation (Guidance Mode), trip planning 
(Planning Mode), and Live messaging/real-time tracking (from within Planning Mode). 

If you launch the CoPilot application without first attaching your GPS receiver, a screen  
will appear (shown below) that lets you choose either Planning or Guidance Mode.  Click 
Planning or Guidance to continue.  If your GPS receiver is attached, you will be taken 
directly into Guidance Mode.

Guidance Mode is for in-vehicle navigation.  
For this mode to function you need to have 
your GPS receiver attached to your laptop and 
you must be receiving signals.  CoPilot will 
guide you to your destination and any stops 
along the way using voice prompts and simple 
on-screen instructions, and track your position 
in real-time on a map.

Planning Mode is for trip planning.  You do 
not need to have your GPS receiver attached 
in order to utilize Planning Mode.  In this 
mode you can plan trips, print directions and 
maps, search for points of interest, add places 
to your database, set road preferences, and 

change system settings and trip options.  Additionally, CoPilot’s Live messaging and real-
time tracking capabilities can be accessed from within Planning Mode.

Live Mode enables you to communicate with a driver who is operating CoPilot and see his 
or her position tracked in real-time on the map.  Or, you can use the Live Web page on the 
internet (see p. 52).

First View of CoPilot 
Without GPS Receiver Attached

CoPilot Truck Overview

TIP:  CoPilot defaults to hiding the Windows Taskbar when in Guidance Mode.  To 
change this, switch to Planning Mode and go to Tools > Options > Guidance and place 
a checkmark next to Show Windows Taskbar.
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Guidance Mode 

Planning Mode

To move from Guidance Mode to Planning 
Mode at any time, click the Planning button in 
the control panel on the right side of the screen.  

To move from Planning Mode to Guidance 
Mode at any time, click the Guidance button 
on the left side of the screen.

Moving Between Modes
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Guidance Mode

Entering a Destination
When you launch CoPilot for the first time with the GPS receiver attached, you’ll be asked 
to enter a destination.  Click Destination, select one of the destination options, then enter 
your destination.  (You don’t need to enter an origin, if the GPS receiver is picking up 
signals, CoPilot will automatically identify the start place.)  

Destination Entry Options 

Address

1. Click Destination, then click Address.

2. Type a state/country name or 
abbreviation.  As you type, CoPilot’s 
type-ahead feature will move to the 
correct state or country in the pick 
list below.  When the correct state is 
highlighted, click Next.
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3. Type a city name or ZIP/postal 
code.  As you type, possible 
matches will appear below.  When 
the correct location is highlighted, 
click Next. 

 TIP: Usually you will need to spell 
 out words like “Saint”, “Mount”, 

“Fort”, etc.  Place names generally 
need to be spelled out; for exam-
ple, “John F. Kennedy International 
Airport” instead of “JFK Airport”.  

4. (Optional) Type a street address, 
with or without a street number.  
As you type, possible matches will 
appear below.  When the correct 
location is highlighted, click Next. 

 If an exact match is not found 
in CoPilot’s database, a list of 
possible options will appear.   
Scroll the list to see all options.  
Highlight one and click Next.
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5. (Optional) Type a name for the place 
you entered and click Next.

6. The Trip Confi rmation window 
appears every time you enter a new 
stop.  You can enter as many as 50 
stops in any given trip.  The screen 
will display your next few stops, and 
your fi nal destination.  (To see all stops, 
click Edit.  To return to the Trip 
Confi rmation window from the Edit 
Stops screen, click Go!)

 Options in this screen are:

· Go! to begin receiving guidance to 
the destination(s) you entered (your 
GPS receiver must be attached);

· Add to add another stop to your trip;

· Edit to change the stop order or 
remove stops;

· Clear to delete all stops and start over.

TIP:  If you are making a quick stop, there’s no need to exit the application.  
Simply close the lid on your laptop and the operating system will enter Suspend 
mode.  When you return to your vehicle, simply open the lid and press any button 
and the operating system will resume.
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Home or Work
The first time you select the Home or Work button 
you will be prompted with an address entry window.  
Enter your home or work address as described on 
p. 14-16.  In subsequent selections, choosing these 
buttons will automatically enter your home or work 
address as your destination.

NOTE: To edit your Home or Work address, switch 
to Planning Mode and use the Favorites tab in the Trip 
Planner window (see p. 38).

Favorite
Every time you add a stop to your itinerary, it will 
automatically be added to a list of Favorites.  To 
quickly enter one of these Favorites as a stop, click 
Destination then click Favorite.  Highlight a place on 
the list and click Add to add it as a stop.  To delete a 
Favorite from the list, highlight it and click Delete.  If 
you exceed 50 favorites, the new Favorite will replace 
the oldest one (the one not accessed for the longest 
amount of time). 

Saved Trip
In Planning Mode you have the option of pre-planning 
trips and saving them to your hard drive.  In Guidance 
Mode, you can enter a planned trip rather than entering 
individual stops:

1. Click Destination, then Saved Trip.

2. Highlight the trip you want on the list of saved trips.

3. Click Open to add the whole trip to your itinerary.

4. To edit the stops on your saved trip, click Edit in the 
Trip Confirmation window.
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POI
To search the CoPilot database for Points of Interest:

1. Click Destination, then click POI.

2. To narrow the search, choose a Type and/or 
Category of POI from the pick lists.  If you're 
looking for a specific place, you can also type the 
first few letters of its name in the Name field.  Click 
Next when ready.

3. If your GPS receiver is attached and you are 
receiving signals, the next screen allows you to 
search for POI along your current route or near 
your current location.

Or, you can have CoPilot execute a search Near a 
city even if your GPS position is unknown.  You 
will be asked to enter a state/country abbreviation 
and city name.

4. CoPilot will provide a list of all POI that meet the 
criteria you selected.  At this point you can:

· highlight a POI and click Finish to add it as a stop;

· click Back to modify your criteria and search again;

· click Expand to search again within a wider area;

· or click Cancel to return to the list of trip entry 
options.

TIP: During the initial installation of the software 
you have to choose between installing the Typical or 
Compact POI set.  The Typical set gives you more 
POIs to choose from.  In order to go back and change 
this option at a later time, click on Start > Settings > 
Control Panel and double-click Add/ Remove 
Programs.  Select CoPilot Truck from the list and click 
on Change/Remove > Modify.  Select the POI set you 
want and deselect the other one.
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Lat/Long
To enter a latitude/longitude point as a stop:

1. Click Destination, then click Lat/Long.

2. Choose a format from the first drop-down pick 
list.  Lat/longs can be entered in Decimal Degrees, 
Decimal Minutes, or Degrees Minutes Seconds 
(DMS).

3. Enter a latitude and longitude in the appropriate 
format, using the drop-down pick lists for N or S, 
and E or W.

4. (Optional) Enter a name for the place.

5.  Click Add to add the lat/long you entered as a stop.

Contact
To enter an address from your Microsoft® Outlook 
Contacts database as a stop on your route:

1. Click Destination, then click Contact.

2. Narrow down your contact search by typing in the 
first few letters of the contact's first or last name and 
hit the <Enter> or <Space> key.

3. Select the contact you want from the list and preview 
the Business, Home, or Other address by selecting 
the corresponding radio button.

4. Click Next to add the contact's address as a stop. 
You will be taken through CoPilot's address entry 
screens, with your contact's address automatically 
filled in.  You can edit the address if necessary.  If 
an exact match is found, CoPilot will automatically 
add it to your itinerary.  If an exact match is not 
found, CoPilot will display a list of possible address 
matches to choose from.
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Intersection
To enter an intersection of two roads as a stop:

1. Click Destination, then click Intersection.

2. Enter a state/country and city name or postal code.

3. When prompted, enter the name of one of the 
intersecting streets and click Next.

4. Enter the name of the other street in the next screen, 
click Next.

5. Optionally, you can also assign a name to the 
intersection.

6.  Click Finish to add the intersection as a stop on 
your route.
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Editing Stops

To edit your existing stops, click Destination in the navigation control panel, then click 
Edit to bring up the Edit Your Stops window shown above.  From this window you can do 
any of the following:

  ·  Change the order of your stops.  Highlight a stop, then click the Move Up or Move 
Down button.

  ·   Delete a stop. Highlighting it on the list and click the Delete button.

  ·   Change a stop to a waypoint, or vice versa (<<Waypoint).  Waypoints can be used 
to guide your route, but CoPilot does not treat them like stops.  The ETA and distance 
to next stop shown in Guidance mode do not consider waypoints as stops, though 
waypoints do appear in the Itinerary.  

  ·  Optimize the order of your stops for the most efficient route.  If there are three or more 
stops on your itinerary, just click Optimize.  NOTE:  To keep your final destination 
fixed in a trip that has four or more stops, in Planning Mode select Options in the Tools 
menu, then in the General tab check “Keep the destination fixed” under “Optimize”.  
The origin always stays the same.

  ·  Click Close to return to the Trip Confirmation window where you can select Go! 
(Guidance), Add (add a stop), Edit (edit another stop) or Clear (delete all stops).
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Start Driving!
If your GPS receiver is attached and you have entered at least one destination, you’re ready to 
start driving!  The CoPilot navigation system will guide you to the destination(s) you enter and 
will automatically recalculate your route should you miss a turn or choose to follow your own 
variation of CoPilot’s route.

Features of the Guidance Screen 
In addition to spoken instructions, CoPilot’s guidance screens provide you with on-screen 
navigation tools, driving directions, and prompts as you drive.  

As you begin driving, the Driver Safety screen will appear when your speed exceeds 10 m.p.h. 
(the map in the guidance screen will disappear).  This is an important safety feature of the 
software, you’ll still receive verbal instructions as well as simple text directions on-screen as 
you drive.  NOTE: When driving in Australia, all screen buttons are disabled in the Driver 
Safety screen. 

IMPORTANT: The driver should pull over to the side of the road when looking at the map 
and/or the Navigation Control Panel.  Even if a passenger operates the computer, for safety 
reasons, the driver should never look at the computer screen while driving.

Next Turn

Your Current 
Location

Customizable 
Display Lines

(see p. 29)

Compass

Next Stop Information
(Estimated Time of Arrival, 

Distance To Go, and
Name/Address)

Map Mode 
Buttons

Speaking 
On/Off

POI Alerts 
On/Off

(see p. 28)

Message Alert
 (see p. 56)

Zoom Buttons

GPS Status:
Green = 3D Fix
Yellow = 2D Fix
Red = No Fix

Auto Snap
(see p. 24)

Listening 
On/Off

(see p. 31)

Truck Restriction 
On/Off Indicator

Live Indicator

HazMat Indicator
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Using the Navigation Control Panel
BUTTON  FUNCTION

View   Lets you pick a screen view (see below).
Destination  Opens a window that lets you add a destination or edit your   
   existing destination(s), or delete all destinations to start over.
Detour   In case of traffic delays, enables you to run an alternate route.
Save Current  Saves your current location as a Favorite or Custom Place.
Live   Lets you change Live messaging options.
Options  Lets you view GPS status and modify routing and guidance   
   preferences, voice options, and map orientation.
Planning  Switches to Planning Mode.
Exit   Exits CoPilot.

Screen Views
Click the View button at the top of the Navigation Control Panel to choose one of six 
guidance display options.

Driver Safety:  Text only screen, switches to the map 
display below 10 m.p.h. (map displays Next Turn view).

Next Turn:  Map screen frames your current position to the 
next turn.  The map zooms in automatically as you approach 
your turn.

Destination:  Map screen frames the view from your current 
position to your fi nal destination. The map progressively 
zooms in as you approach your destination.

Where Am I: Map screen frames a close-up view of your 
current position.  Zoom level is constant.  (Use the Zoom In 
and Zoom Out commands to change the zoom level.)

3D View: Displays the map screen in 3D.

Trip Itinerary Screen: Basic text overview of all your 
upcoming turns.



Zooming Your Map View
Buttons to the right of the map let you zoom and shift your map view.  The Autosnap 
button in the lower right corner automatically centers your current position on the map.
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Drag Map:  Click to activate Drag 
Map mode, then place your cursor on 
the map and press, hold and drag to 
shift the visible area up, down, left, 
or right.

Zoom In:  Click to zoom 
in one level.

Zoom Out:  Click to zoom 
out one level.

Box Zoom: Click to activate Box 
Zoom mode, which lets you zoom to 
an area on the map by drawing a box 
around it with the cursor.  This mode 
is turned on by default.

Next Turn Map View Where Am I? Map View

Destination Map View 3D Map View

Auto Snap:  When on, your 
current position is always at 
the center of the map.  Turn 
off when you want to view 
other areas on the map.



Detour

In Guidance Mode, clicking the Detour button will cause CoPilot to generate an alternate 
route around the next few miles of your trip.  This is useful when you need to get around 
traffic jams, roadwork, or other unexpected traffic slow-downs but don’t know whether or 
not you’ll save any time by turning off your current route.  The Detour button toggles to 
Cancel Detour after an alternate route is calculated, so that you can return to the original 
route at any time if you choose. 
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Save Current Location

When you have a GPS fix in Guidance Mode, 
you can press the Save Current button in the 
control panel to save your current location.

CoPilot will ask you to give the location a 
name and will add it as either a Favorite or a 
Custom Place.
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Using the Itinerary for Selective Routing

CoPilot enables you to be selective about the roads you take on your trip.  You can 
customize your Itinerary so that entire segments of a trip can be avoided if you don’t want 
to travel along the roads CoPilot has you taking.  (Note that you can also use waypoints to 
guide a route along roads of your choosing, see p. 26.)

To avoid specific road segments, in Guidance Mode click View > Itinerary to bring up your 
turn-by-turn driving directions.

In the Itinerary screen, highlight the road you want to avoid, then press the F1 key on your 
keyboard or click the Avoid Rd. button to avoid the highlighted road.  You can return to 
your original route at any time during the trip by pressing F2 or clicking Original Rt. (this 
button appears when you choose to avoid a road segment).  Click View to close the Itinerary 
and choose a different view.
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Options

GPS Status

In Guidance Mode, click the Options button to 
check your GPS status and change the settings 
that control map orientation, voice options, and 
routing and guidance preferences.

In the Options window, the GPS Status button 
opens a window that allows you to view GPS 
data and/or initiate a CoPilot search for your GPS 
receiver.

Choose Manual if you know the COM Port 
CoPilot should search and the Baud Rate of 
your receiver; otherwise, choose Automatic and 
CoPilot will automatically adjust these settings 
when it finds your receiver.  Either way, click 
Find GPS to begin the scan. 

Reset GPS lets you enter a city, state from where 
CoPilot can search for satellites.  Typically this 
search is based off your last location, but Reset 
can speed up acquisition if you’ve traveled a 
long distance without using CoPilot (for example, 
if you’ve flown on a plane from New York to Los 
Angeles).

To create a log file of your GPS tracks, check 
Log all GPS messages. These will be saved in 
the “GPS Tracks” folder of your installation.
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POI Alerts

As you drive, CoPilot can alert you with a voice 
prompt and a message window on your screen 
each time you approach a Point of Interest.  This 
features can be turned on and off by toggling the 
POI Alerts button in the lower right corner of the 
Guidance Mode screen. 

Use the POI Options window to set preferences for 
this feature.  In the Select POIs to be reported 
scroll list check all categories of POIs you want to 
know about.  For example, you might only want 
to know about restaurants, gas stations, and nature 
attractions.  

Use the Search __ miles ahead pick list to indicate 
how far up the road you want each POI to be when 
an alert is triggered.  Use the sliding bar under 
Report POIs which are to indicate whether POIs 
trigger an alert only when precisely on your route, 
or if those close to your route will also be reported.  

The Hide windows after pick list lets you select 
how long you want each POI alert to remain on 
your screen.

In the alert window, you can click the forward 
arrow to scroll through nearby POIs, click the Add 
Stop button to add this POI as a stop, or close the 
window.
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Guidance Click Guidance for guidance options settings.

Display GPS Arrow Trail controls whether the arrow 
that trails your position is displayed on the map as you 
drive.  Display Small GPS Arrow controls the size of 
the tracking arrows on the map.

Speak Turn Warning At:  Set how often CoPilot will 
give you next turn information out loud.  All, none, or 
some boxes can be checked.  Just Ahead:  By default 
you will be alerted 5 sec/100 ft before every turn (5 
seconds or 100 feet, whichever is closest), but you 
can choose to have CoPilot speak to you sooner (2 - 8 
seconds before each turn, or 100 ft.) using the pick list.  

Custom Display:  Select the information you want 
displayed on your screen as you drive.  Choices are the 
same for each line: the current road, nearest crossroad, 
nearest major road, nearest town, ETA, or speed.  (Line 
3 only appears when the map is hidden in the Driver 
Safety view.)

Map Options Click the Map button for map display options.

Heading Up tracks your position on the map moving 
upward as you drive, whereas North Up maintains 
north at the top of the screen.

With Drag Map selected, you can use the mouse to 
drag the map in any direction to a desired location.  
With Box Zoom selected, you draw a box around an 
area to zoom to it.

Display POIs and Display Turn Restrictions control 
whether POIs and turn restrictions are displayed on the 
map.  If your map seems too cluttered, you may want 
to turn off these options.

Mode options control map appearance. Choices are:
Day (default), Night (reduces glare for night driving) 
or Automatic (determines whether it is currently day or 
night using GPS, and switches automatically.
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Routing Preferences

To set routing preferences in Guidance Mode, click 
Options, then click Routing in the Options menu.  
Note that the changes you make here will carry over to 
Planning Mode, and vice versa.

Routing Type

NOTE: See Appendix A, PC*MILER Route Types and 
Options on p. 71 for more detailed descriptions of the 
route types and options available with CoPilot Truck.

Practical routes include distances and driving routes 
that a driver would normally take to minimize time 
and cost, based on efficiency in terms of road quality, 
terrain, and urban/rural classifications.  Practical 

routing models the trade-off between taking the most direct path and staying on major, high 
quality highways.  

Shortest routes include distances and driving routes that minimize total distance traveled 
while still following a reasonable route.

Routing Options

When Avoid Tolls is checked, CoPilot’s route calculations will avoid toll roads where it is 
possible to do so while maintaining a reasonably practical and efficient route.  

Check National Network for National Network routing or 53’ Trailer to get routing that is 
suitable for 53’ and over-sized trailers.  

Check International Borders Open to have routes cross international borders where this 
provides better routing.  If this option is not checked, no borders will be crossed even where a 
route becomes impractical. 

Check Override Restrictions to activate Light Vehicle routing.  CoPilot Truck always avoids 
truck-prohibited roads, but checking this option allows truck-restricted roads to be considered 
for a route.  If this option is left unchecked, Heavy Vehicle routing will be in effect, so both 
truck-prohibited and truck-restricted roads will always be avoided.  In addition, Heavy Vehicle 
routing takes nationwide 13' 6" height restrictions into account.  This setting affects which 
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roads trigger a truck restriction warning on your screen (see p. 33).  When this option is 
checked, the Override Restrictions indicator in the upper right corner of the guidance screen 
will be gray.

Check HazMat Routing for a route that avoids roads where hazardous material route 
restrictions are in effect.  This option provides industry-standard general hazardous materials 
truck-specific routes.  See Appendix A on p. 71 and the CoPilot Truck Help files for details.  
When HazMat routing is in effect, the Hazmat Routing indicator will display in the upper 
right corner of the guidance screen.

To have breaks included in driving directions and ETA calculations on a route, check Break 
Every and enter time parameters.

Speech

Use the Language and Speech options to choose 
a language, voice format, and voice (male 
or female) for CoPilot's spoken directions.  
CoPilot not only speaks to you to inform you of 
upcoming turns, but also responds to a number 
of commands you speak out loud using voice 
recognition technology.  Commands you can 
speak to get a response from CoPilot are listed 
in the What can I say? scroll list.  See Voice 
Commands, next page, for descriptions.

NOTE:  For CoPilot to listen and respond, the 
Listening button must be toggled on in the lower 
right corner of the Guidance screen.  In the 
picture below, the red circle with an “x” indicates 
that Listening is off, and Speaking is on so 
CoPilot will speak directions out loud.

Speaking 
Button

Listening 
Button
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Voice Commands

NOTE: Background noise may affect CoPilot’s ability to recognize spoken commands.  
You can use an external microphone with noise-cancellation technology to optimize your 
experience with CoPilot’s listening device.

COMMAND RESPONSE

Cancel Detour Returns you to the original route after a detour has been generated.
Clear track Clears the GPS arrow trail from the map.
Detour CoPilot automatically calculates an alternate route.
Driver Switches to the Driver Safety view.
ETA CoPilot tells you the estimated time of arrival at your next stop.
Go to sleep CoPilot will enter Sleep mode — the application stays open   
 but is not active.  Use the “Wake Up” command to reverse.
Going to CoPilot tells you the name of your next stop. 
Heading CoPilot tells you which direction you are heading. 
How far CoPilot tells you the distance to your next stop.  
Less detail Each time spoken, the map will show less detail.
More detail Each time spoken, the map will show more detail.
Mute Turns CoPilot’s spoken directions off. 
Next Turn CoPilot tells you when (estimated) and where you will make   
 your next turn.
Pan down/left/right/up Each time spoken, the map view will shift down, left, right, or   
 up from the currently displayed area.
Passenger Switches to “Next Turn” view.
Resnap Recalculates your GPS position.
Speak all Speaks useful statistics about your current positon and route.
Speaking off/on Turns CoPilot’s spoken instructions off/on (text instructions still  
 appear on-screen when speech is turned off).
Speed CoPilot tells you the speed at which you are currently traveling.
Thank you “You’re welcome!”
Wake Up Brings CoPilot out of Sleep mode.
Where am I? CoPilot tells you your current location along the route.
Zoom in/Zoom out Zooms the view of the map in or out one level.
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Speed Warning

You can tell CoPilot to alert you when your speed 
exceeds a limit that you specify.  To do this, check  
“Display a warning” and use the pick list arrows 
or type in a speed limit, then click OK.  Check "Play 
a sound" if you hear the warning.

CoPilot will then issue a warning on your screen and/
or out loud when your speed exceeds the specified 
limit.  Warnings appear in the lower right corner 
when the map is displayed, or the lower left corner in 
the Driver Safety View.  The warning will disappear 
after 5 seconds, and won’t reappear unless your speed 
has dropped below the limit and then risen above it 
again.  

Truck Restriction Warning

CoPilot will issue a warning when you turn onto a 
truck prohibited road.  Tap Acknowledge Warning 
to return to the guidance screen.

This alert will also appear when you drive on a 
truck restricted road unless Light Vehicle routing 
is activated.  To activate Light Vehicle routing, in 
Guidance Mode click Options > Routing and check 
Override Restrictions (see p. 30).  
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A Sample Trip
Suppose you’re delivering a load to the campus of Princeton University in Princeton, New 
Jersey.  You know the address of your destination, but you're unfamiliar with the area.  
Never mind, CoPilot will guide you every step of the way!

First, you enter your destination.  (You won’t need to enter a starting place – if your GPS 
receiver is picking up signals, CoPilot already knows where you're starting from.)  In 
Guidance Mode, you click Destination, then Add, then Address.  You type "princeton 
university, nj" in the City,  State, or ZIP Code box and click Add.  In a few seconds, 
CoPilot finds "Princeton University" in the database.  Then you click Go!  

Now you're ready to drive to your destination.  

Once the truck is moving, your location shows up as a series of arrows drawn on the map.  
A green-highlighted line from your present location to your destination shows the route for 
you to follow.  In addition, CoPilot prompts you before each turn if Speaking is turned on.

CoPilot leads you into Princeton without a problem.  However, as you drive along 
Witherspoon Street approaching the center of town, you see a traffic jam caused by an 
accident up ahead.  You decide to turn onto Wiggins Street in order to save some time.  

No Problem!  Within seconds, CoPilot tells you that you are no longer on the correct route 
and warns you to obey local traffic regulations.  You acknowledge CoPilot’s warning with 
a click of the mouse, then CoPilot automatically gives you new directions to follow from 
your new position.  Your delivery arrives on time and you enjoy a relaxing trip.
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1.  Driving on Witherspoon Street into Princeton, NJ

3.  CoPilot automatically creates a new 
route from your current position

2.  Turning off CoPilot’s route onto Wiggins Street

Sample Trip on the Map



Planning Mode
After launching CoPilot you can access Planning Mode by clicking the Planning Mode 
button from the welcome screen or the Planning button in the guidance screen.  In Planning 
Mode you can run trips on your desktop to print and take with you or save for a later time, 
search for points of interest, calculate fuel costs, add favorite places, add custom places, and 
much more.  For additional information on Planning Mode see CoPilot’s Help Files (select 
Help Contents and Search from the Help menu).  

The Trip Planner Window
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To access the Trip Planner window use 
either the New Trip button on the tool bar, 
or select New Trip from the drop-down 
Trip menu.

In the Trip Planner window you’ll enter 
a start place, end place, and any stops in 
between on your trip.  



Cities and Addresses
To enter a trip, begin by typing the name of the place where your trip will start or a postal 
code in the City, State (or City, Country) box (e.g. “princeton, nj” or “paris, fr” or 
“08540”), then press the Enter key.  Do not include periods in the state/country abbreviation.  
A list of matches to your entry may appear; if so, highlight the one you want on the list and 
click Select.  

TIP:  You can click on the pick list arrow at the end of the City/State box to see a list of 
all locations that have previously been entered as stops.  Select any location from the list to 
quickly enter it.

To enter a street address, click in the Address box. (This is not required.  If no street address 
is entered, CoPilot will route from a point at the center of the city or town you selected.)  
Again, a list of matches to your entry may appear; if so, highlight the one you want on the 
list and click Select, or click Map to see it on the map.  If you enter a street address you can 
also assign a name to the address by typing it into the Name box. 

You can enter a crossroad as a stop by using an ampersand (&).  Example: If you want 
to go to the corner of Main Street and Washington Street, type “Main & Washington” in 
the Address field.  You might see a list of matches - these are addresses where the streets 
intersect.

Click the Add Stop button to put the place you entered in the Trip 
Itinerary.  You can then highlight it and click the Zoom To button 
to see that place on the map.

HINT:  If you need help with the spelling of a city name, type the first few letters (at 
least two) plus the state abbreviation and press <Enter>.  Then highlight the place on the 
list and click Select.  Spelling help for street names is accessed by entering the first two 
or more letters of the street name.  The pick list will take longer to come up when there 
are more matches to your entry in the database.

- 37 -
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Points of Interest
When you select the Points of Interest tab, it will open with the cursor in the POIs that 
start with box.  The only field that is required to perform a POI search is City/State (or 
City/Country); all other fields are optional.  Once you have entered a city, you can do one 
or more of the following to narrow down your search: select a POI Category, select an 
of Type option, or enter the first few letters of the Place name.  You can also change the 
distance within which you want to search. 
 
When you are finished entering in your search information, click the Find button to get a 
list of all possible matches within the database.  To select one, highlight it by clicking on it 
and choose Select to add the place to your itinerary, Cancel to return to the search, Map to 
show the place’s location on a map, or Clear to change your selection.  For information on 
changing the POI set, see page 32.

Favorites
To save a place as a favorite you must first add it to your Itinerary using the Cities and 
Addresses or Points of Interest tab and then click Add Fav.  When you click on the 
Favorites tab you will see a list of your previously saved favorite places.  To add a favorite 
place to your trip, highlight it and click Add Stop.  In this tab, you can also specify a 
Home and Work address.  To do this, highlight an address on the list of favorites and click 
the circle next to Home or Work under the list.  Now your home or work address can be 
quickly selected as a destination in Guidance Mode.  Remember that while you can access 
your Home and Work address from Guidance Mode, they can only be changed through the 
Favorites tab in Planning Mode.

Contacts 
You can access your Outlook Contacts database by clicking on the Contacts tab.  Narrow 
down your contact search by typing in the first few letters of the contact’s first or last 
name and hit the <Enter> or <Space> key.  Select the contact from the list and preview 
the Work, Home, or Other address by selecting the corresponding radio button.  Click on 
the Add Stop button and CoPilot will search for that contact’s address.  If an exact match 
is found, CoPilot will automatically update your itinerary.  If an exact match is not found, 
CoPilot will display a list of possible address matches to choose from.
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Itinerary Buttons 
Regardless of the tab you select, the same commands will remain in the bottom of the Trip 
Planner window.  To the right of the Itinerary you will see five buttons.  Using the Up/Down 
arrows you can alter the order of the stops on your Itinerary.  Using the Zoom button you 
can zoom to the selected stop on a map.  The Delete Stop button allows you to remove stops 
from your trip.  And the Add Fav button lets you add a stop entered on your Itinerary to 
your saved list of favorite places (see p. 38).

Stop Optimization
After you’ve added all your stops to the Trip Itinerary, you can click the Optimize button 
and CoPilot will automatically re-order the stops to create the most efficient route.  If 
you don’t optimize, your trip will be routed in the order in which the stops appear on the 
Itinerary.  To always keep the last stop in your Trip Itinerary as your final destination, select 
Tools menu > Options.... > General tab and check Keep the destination fixed when 
optimizing a trip.

Fuel Cost Calculator
To calculate an estimate of your fuel costs for a trip, select Fuel Cost Calculator from the 
Trip menu before you run your route.  Fill in the average cost per gallon of fuel that you 
expect to pay, and the average number of miles per gallon you can expect to get in your 
vehicle.  Click OK, then run your trip.  A fuel cost will appear along with time and distance 
estimates in the trip summary CoPilot creates for every trip.

Fuel Cost Calculator Trip Summary with Fuel Cost



Running the Trip
To see a complete map of your trip, as well as detailed, turn-by-turn driving directions, click 
Run.  To generate a round trip, click the Round Trip check box before clicking Run.  A 
round trip includes all intermediate stops on the way to your destination, but routes directly 
from your destination back to your starting place.

Options, Clear, Help
Click the Options button in the Trip Planner window to change your travel speeds, route 
type, and road preferences (see below for more on Trip Options).  The Clear button cancels 
the trip you have been planning and allows you to start a new one.  For more information 
about the Trip Planner window and trip planning, click the Help button.  

Trip Options

Click Options in the Trip Planner window to 
change various routing preferences.  The options 
here are the same as the routing options in Guidance 
Mode. Note that options set here affect route 
calculations in Guidance Mode and the reverse is 
also true. 

Routing Type
Practical routes include distances and driving 
routes that a driver would normally take to 
minimize time and cost, based on efficiency in 

terms of road quality, terrain, and urban/rural classifications.  Practical routing models the 
trade-off between taking the most direct path and staying on major, high quality highways.  
Shortest routes include distances and driving routes that minimize total distance traveled 
while still following a reasonable route.  See Appendix A p. 71 for more on route types.

Routing Options
When Avoid Tolls is checked, CoPilot’s route calculations will avoid toll roads where it 
is possible to do so while maintaining a reasonably practical and efficient route.  Check 
National Network or 53’ Trailer to get routing that is suitable for 53’ and over-sized 
trailers.  Check International Borders Open to have routes cross international borders to 
provide better routing.  If this option is not checked, no borders will be crossed. 
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Override Restrictions: Check to activate Light Vehicle routing.  CoPilot Truck always 
avoids truck-prohibited roads, but checking this option allows truck-restricted roads to 
be considered for a route.  If this option is left unchecked, Heavy Vehicle routing will be 
in effect, so both truck-prohibited and truck-restricted roads will always be avoided.  In 
addition, Heavy Vehicle routing takes nationwide 13' 6" height restrictions into account. 

HazMat Routing: Check to generate routes that avoid roads where hazardous material route 
restrictions are in effect.  This option provides industry-standard general hazardous materials 
truck-specific routes.  See the CoPilot Help files for more details (Planning Mode > Help 
menu > Help Contents and Search).

Check Break Every to include a break time that shows up in your on-screen itinerary and is 
added to the estimated time of arrival (ETA) calculations. 

Units: Choose Miles or Kilometers.

Optimize: Use this option to set the default for stop optimization (see p. 39).

Avoid Propane-Restricted Tunnels: Check to avoid propane-restricted tunnels.

Advanced Options
Use the advanced routing options to completely change how CoPilot calculates routes.  
Advanced options include avoid/favor preferences and average speed settings for each road 
type CoPilot uses in route calculations. 

1)  Click the Advanced tab.  
2)  Tap New to create a new Profile.
3)  For each road type, use the slider bars to set the 
avoid/favor level and select or type a road speed.  
There are five levels of avoid/favor for each road 
type.  From left to right they are: Strongly Avoid,  
Avoid, Neutral, Favor, Strongly Favor.  Note that 
a road type that is heavily avoided will not be 
completely excluded — CoPilot will still use that 
road type if there is no other efficient alternative.
ALSO NOTE: Even small changes to the avoid/
favor balance will have a significant effect on how 
CoPilot calculates routes.

4)  Type a name for this profile.  
5)  Click OK.  Your new profile is now saved.
6)  In the Routing Preferences window, check Confirm Profile when Routing if you want 
to be prompted to select a profile before each trip.
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Printing Your Map or Driving Directions

After you run a trip, the Trip Summary 
window will pop up over a split screen 
displaying the map of your trip and 
detailed driving directions.  Click OK 
to hide the Summary window (you can 
get it back again using the View Trip 
Summary option in the Trip menu).  To 
alter the size of either the map window 
or the directions window, drag the gray 
bar that divides them to the right or left.

NOTE: To see the scroll bar in the 
driving directions window, you may 
have to click in the window.  

The map and driving directions that CoPilot generates can be printed.  To activate either 
window for printing, click on it (only the active window will be printed), then click the Print 
button on the tool bar or select Print from the File menu to print. 

You can also select Print TravPak from the File menu to print a series of maps providing 
different views of your trip, plus detailed driving directions.

State Mileage Report

To generate a state mileage report for any trip you run 
in the Trip Planner window, open the File menu and 
choose State Mileage Report. 
 
In the report window, click Export if you want to save 
your state mileages in a .txt file.
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Beyond the Basics
If you’re familiar with the basic features of CoPilot, you’re probably ready to try some of 
the advanced features.  Some of these features are briefly described on the following pages.  
For more information on advanced features see the Legend on page 59 of this manual, and 
see Trip Planning: Beyond the Basics in the Help Files (under Planning Mode in the 
Contents tab). 

Picking Stops from the Map
To pick a stop from the map with the mouse, first zoom into the area from which you want 
to select a location.  Then open the Map menu and select Pick Stops from the sub-menu of 
Mouse Modes, or click on the Pick Stops button on the tool bar.  With Pick Stops turned 
on, click with the left mouse button on the location you want to add to your trip (it can be a 
city or any location, including a local address or latitude/longitude point).    

When you pick a stop, the Add to Trip Planner dialog box will appear.  You may add 
the location as 1) the start place, 2) a stop, or 3) the end place.  (Note that any previously-
entered start or end place will become a waypoint if a new start or end place is chosen.)  

Now click on OK to close the dialog box, 
then select Edit Trip from the tool bar to 
bring the Trip Planner window forward.  
You'll see that the stop you picked now 
appears as either the start or end place, or an 
intermediate stop on your Trip Itinerary.  

Click on the Run button to rerun your trip 
with the new stop.  You can pick multiple 
stops from the map before re-running the trip 
if you wish.
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Adding Custom Places
CoPilot gives you the ability to add new places with your own custom names to the map 
database.  After adding your custom place to the map database, you'll be able to enter it as a 
start place, end place, or waypoint for any trip you run.

To add a new place, click on the Add Custom Places button on the tool bar or select Add 
Custom Places from the sub-menu of Mouse Modes in the Map menu.  The map window 
should be open and active, and be at a zoom level of 10 or higher (look at the title bar, e.g. 
"Detail Level 10 of 12").

Now click on the spot on the map where you want your new place to be added.  The Add 
Custom Place dialog box will appear.  

Type your custom name for the place in the PlaceName box.  The name you enter must be 
50 characters or less, including spaces, and must start with a letter (not a number or symbol).  
You must also enter the address of the custom place.  It does not need to be exact, it is only 
used to describe the custom place.  Optionally, enter a phone number and choose which 
POI category this place should be included in.  Click Apply to save the place and see it as a 
pushpin on the map.

To access this place at a later time, select Manage Custom Places... from the Tools menu 
(see Editing Custom Places, p. 47).
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Avoiding and Favoring Roads
CoPilot gives you the ability to avoid or favor specific road segments.  This Planning Mode 
feature is handy when you want your route to avoid a traffic jam or road construction, and 
can also be used to guide a trip along a route you know you want to take.

To avoid or favor a road, first click either the Avoid or Favor button on the tool bar, then 
click on a road segment on the map.  Zoom your map view in as far as you need to in 
order to pick the right segment.  You can pick one or several segments on th same road.  
Red cross-hatching indicates an avoided road segment, green cross-hatching indicates the 
segment is favored.  The example below shows an avoided portion of Route 27 outside of 
Kingston, New Jersey.

Avoid and favor preferences can be edited in the Custom Roads Manager.  Select Manage 
Custom Roads from the Tools menu.  Avoid/favor preferences you set in Planning Mode 
will be active in Guidance Mode. 

No Avoid/Favor Modifications Route 27 Will Be Avoided



Importing Custom Places
CoPilot’s Custom Place Import Wizard enables you to import addresses from your Outlook 
Contacts database, an Excel file, or text file.  (If you are using another type of database 
or contact manager, you can export your contacts/locations to an Excel or text file before 
importing them into CoPilot.)  These points are then added to CoPilot’s POI database, in 
a category and type of your choice.  Once in the database, they are displayed on maps as 
pushpins and included in search results when you search for points of interest in either 
Planning or Guidance Mode.  NOTE: CoPilot now allows importing of multiple POIs with 
the same name (e.g. an entire database of “Starbucks”).

To import, choose Import Custom Places from the Tools menu in Planning Mode, then 
follow the step-by-step instructions given by the Wizard.  Use the Data Import Status 
window to edit any addresses that were not accepted during the importing process, then 
click Add to import the final list of addresses.  For more detailed instructions, refer to the 
CoPilot Help files on your desktop (Help Contents and Search in the Help menu).

.OV2 File Importing

.OV2 file sets of POI can now be imported.  Simply place the .OV2 file in the Save folder 
of your CoPilot installation (usually Program Files/CoPilot/Laptop 9/NA/Save), then restart 
CoPilot and you will see these POI on the map.  To use your own bitmap to represent these 
POI, also place a bitmap file in the Save folder along with the .OV2 file.  Note that both 
files will be deleted from the Save folder once CoPilot restarts.

Example:  You have a file called ‘walmarts.ov2’ with all Walmart locations.  If you load an 
image of a large W called ‘walmarts.bmp’ along with the ov2 file, CoPilot will display that 
image for that POI set.
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Editing Custom Places
After custom places have been added to the database, they can be edited at any time.  Select 
Manage Custom Places from the Tools menu, then highlight the custom place you wish to 
edit, click Edit, and make your changes.  Click Apply when finished.

NOTE:  By default, addresses entered as Custom Places are assigned to the Custom POI 
category.  You can change this assignment at any time by selecting another Category from 
the drop-down pick list as you edit.
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Customizing Your Driving Directions Display
CoPilot gives you precise, turn-by-turn driving directions, plus time and distance 
calculations for every trip you run between a start place and a destination.  Print these 
directions, and/or customize them by editing the font CoPilot uses and by controlling the 
number of “nearby places” -- that is, landmarks or places of interest in the area surrounding 
your route -- that appear in the report.

To change the appearance of your driving directions, choose Change Fonts from the sub-
menu of Itinerary Fonts in the Edit menu.  This opens a standard Windows dialog box that 
allows you to change the size and style of the font in the driving directions as you would in 
any Microsoft Word document.
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To control the number and type of landmarks reported, select Landmark Reporting from 
the Trip menu to open the Landmark Reporting dialog box.  

NOTE: You can use these options in Planning Mode, but not in Guidance Mode.

Use the slide bar under Find landmarks within this distance of your route to control the 
size of the area around your route in which landmarks should be reported.  If you simply 
want to exclude all landmarks from your driving directions to avoid clutter, move the slide 
to 0 and click OK to close the dialog box.  You can also have landmarks reported only along 
certain types of roads.  Under Find landmarks when driving on these kinds of roads, use 
the check boxes to include or exclude the listed road types.

To increase or decrease the number of landmarks reported, use the slide bar under Report 
this quantity of landmarks in the driving directions.  

TIP: The more places you want reported, the more time it will take to generate the driving 
directions and map for your trip.

You can also select which categories of landmarks you want reported.  Place a checkmark 
next to each category to be included by clicking in the box next to the category name.
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Legend
Planning Mode Tool Bar Buttons:

Open/Save Trip:  Allows 
you to save a trip you have 
outlined in Planning Mode, 
or access a previously saved 
trip.

Edit/New Trip:  Prompts the 
Trip Planner window where 
you can enter addresses, 
search for points of interest, 
and recall favorites.

Run:  After finalizing your 
Itinerary the Run button will 
calculate your trip and give 
you detailed instructions.

Print:  Prints the active 
screen in Planning Mode.  
You can also use the Print 
command in the File menu.

Avoid/Favor Road:  Click 
one of these buttons, then 
click a road segment on the 
map to avoid or favor it.

Help:  In any window, 
the Help button will direct 
you to the Help topic that 
describes how to use that 
window.

Zoom to Entire Region:  
Zooms to a map of the entire 
region selected in the Map 
menu.

Zoom In/Out:  Allows you 
to zoom in or out for various 
views of your map.

More/Less Detail:  Allows 
you to view the map with 
more or less detail.  The 
more detail, the longer the 
map will take to load.

Toggle Trip Views:  Cycles 
the window display from a 
split screen (Trip Map and 
Itinerary) to map only to 
itinerary only (available only 
after a trip has been run).

Refresh Map:  Immediately 
redraws the current map for 
you.

Map Features:  Prompts a 
dialog box where you can 
activate or deactivate certain 
features on your map.



- 51 -

Buttons in the Trip Planner Window:

Label Cities and Places:  
Allows you to label or 
unlabel cities within your 
map.

Add Custom Places:  
Allows you to label specific 
places on the map and save 
them in your Points of 
Interest database (map detail 
level must be at least 7.)

Zoom to Stop:  Zooms your 
map view to the stop that 
is highlighted on the Trip 
Itinerary.

Delete Stop:  Removes the 
highlighted stop from your 
Itinerary.

Clear:  Clears all stops 
entered in the Trip Planner 
window to enable a new trip 
to be entered.

Optimize:  Click this 
button to reorder the stops 
in the Itinerary for the most 
efficient route (requires at 
least one stop).

Pick Stops:  Allows you to 
pick stops directly from the 
map and add them to your 
trip Itinerary.

Label Roads:  Lets you 
determine whether individual 
roads on the map will be 
shown with or without 
names.

Scroll Up/Down:  Moves the 
currently highlighted stop up 
or down in the Trip Itinerary.

Add Fav:  Adds the 
highlighted stop to your list 
of favorite places once it has 
been entered into the Trip 
Itinerary.  

Options:  Lets you change 
your trip type, travel speed, 
and roads which you want to 
favor or avoid.

Send:  Sends the active trip 
via Live messaging.



CoPilot Live Communications
CoPilot Truck allows you to maintain two-way communication with drivers who are using 
CoPilot and to actually see where they are currently located.  You can do this from the 
CoPilot Live web page.

Using CoPilot Live functionality requires the following:

1) If you want to track and message other drivers from a desktop or laptop 
computer:  Your PC must be connected to the internet so that you can access our 
CoPilot Live web page through a normal web browser.

2) If you want others to track and send messages to you:  CoPilot Live must be 
running on your laptop in your vehicle.  You must have a wireless Internet connection. 

About the CoPilot Live Web Page
As a CoPilot user, you can create an account on our website that allows your family, friends, 
and coworkers to “see” you and communicate with you anywhere in the world!  

Through the website you can do all of the following:

•    Send text messages to CoPilot users on the road, using large, customizable, one-touch 
response buttons to ensure driver safety.

• Real-time tracking of other people who are on the road.  See their current location, 
destination, ETA and much more on a map.

• Send trip itinerary updates including new stops and revised destinations — you can 
coordinate a change in plans with someone who’s on the road right now.

• Create an online account from where you can send temporary or permanent tracking 
numbers to friends and family, giving you tighter control of the security so you know 
who has access to you while you’re on the road.  You can also create and join groups 
with other CoPilot users, and manage all your account preferences.

To see a demo and read more about CoPilot’s Live capabilities, visit ALK’s CoPilot Live 
web page at http://live.alk.comhttp://live.alk.com (North America) or http://live.alk.eu.com (Europe).  Click 
the Demo or Help button at the top of the home page.
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Set Up a CoPilot Live Web Account
To use Live capabilities, your laptop PC must have a wireless Internet connection.  To 
create your account on the CoPilot Live website:

 1. Go to the web site for your region:
• North America: http://live.alk.com
• Europe: http://live.alk.eu.com

2. Choose an Account Name and Password that you will use to login to the
CoPilot Live network.

3. Fill in the rest of the required information.

4. Click “Submit” to create your account.

Set Up Live in CoPilot
To enable tracking and messaging, you (the driver) must first create a login account using 
the CoPilot Live Web login page as described above. Once you have submitted a User Name 
and Password on the web, you then enter the same user name and password — once only 
— within the CoPilot application to complete the setup. 
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1.  Open a CoPilot Live account.
Go to the CoPilot Live Web login page 
and set up a new account as described 
above.

2.  Set up Live in CoPilot.
Open CoPilot.  In Guidance mode, click 
the Live button.  Once you are set up 
(see steps below), from this window 
you’ll be able to turn the connection 
to the Live Network on or off, toggle 

messaging on or off, and specify how long Live messages are displayed if no action is 
taken to interact with the messages when they appear. 

3. Check Enable Live Network to enable tracking, click Enable Messenger so messages 
can be sent and received, then click OK. 
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4.  In the window that opens, enter a 
Screen Name that will identify you to 
the person on the other end for messaging 
and tracking.  (This name can be changed 
as many times as you like.)  You can also 
use the Send position information pick 
list to change the interval at which your 
vehicle’s position will be updated as you 
are tracked.  Click OK to continue.

5.  The first time you do this, a message 
will pop up that informs you about the 
CoPilot Live setup process.  After you 
have read the message, click OK to 
proceed.

6.  Now you must enter the same User 
Name and Password that you entered 
when you created your account on the 
Live Web page.  Click Apply to complete 
the driver-side setup process.  

You are now set up for messaging and tracking.  Your screen name and /or password can 
be changed as many times as you like.  Your password must be changed from the Live Web 
page.  Your screen name can be changed at any time from within CoPilot — click Settings 
in the Live Options window.

Your Live connection status is shown in the upper right corner of the Guidance Mode screen:

•  Green — Good.

•  Yellow — OK.  Usually seen when first connecting or in poor GPRS coverage.

•  Red — No connection.  Check your GPRS network coverage and Live settings.
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Driving with Live — Invitations
Using CoPilot Live's Invitations, you can send a tracking number to friends and family via 
e-mail so they can see where you are and communicate with you as you drive.  Each e-mail 
Invitation — similar to an e-card — contains a link to the CoPilot Live Web page, a tracking 
number, and an invitation to the recipient to log on to the CoPilot Live Network.  (To see an 
Invitation, try sending yourself one using the instructions below.)

Only those who have access to your tracking number can see you and send/receive messages 
on the Web.  CoPilot gives you the option to turn off any tracking number you send so that it 
becomes invalid after a specifi ed number of days.  For the recipient of an Invitation to see you, 
both of you must have an internet connection and you must be using CoPilot and receiving 
GPS signals in your vehicle.

To send an invitation:

1. In the Guidance screen, click Options > Live > Invitations > New.

2. Enter the name of the recipient (this will appear in the e-mail) and, if you want to set an 
expiration date for the tracking number, check “Turn off in” and enter a number. 

3. Click Send, then type the recipient’s e-mail address and click Send.

You can invalidate a tracking number manually at any time before it’s due to expire: highlight 
the invitation and click Deactivate.  To restore it, click Activate.

To delete an invitation from the list, highlight it and click Delete.  To edit the name of the 
recipient, click Edit.



Driving with Live - Receiving Messages

On the top are the four Standard Response Buttons, which appear on every message: 

Speak Message:  CoPilot's text-to-speech engine speaks the text of the 
message.

Defer Message:  Defers the message, which will reappear later.  Useful 
when you need to concentrate on the turn instructions 
and the road.

More Information:  Sends a response back that you need more information.

Delete Message:  Deletes the message. Notice of the delete is sent back.

You can also tap one of the Customizable Response Buttons that the message sender has 
included at the bottom of the screen.  The text on the button is sent back as the response.
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When you are the driver and a message is 
sent to you, CoPilot displays it on top of 
all other windows.  CoPilot's text-to-speech 
engine will speak the text of the message 
out loud when the message is received.  If 
you hit the Defer button (see below) or do 
not respond within the time limit you have 
set (see p. 54), the message will be put in 
a queue and the Hidden Messages button 
in the lower right corner of the Guidance 
screen will light up. Click this button to 
read the message.  If other messages have 
been queued behind it, messages will appear 
in the order they were sent.



Driving with Live - Receive Trip Itinerary Updates

When you are the driver and a Trip Itinerary Update is sent to you, CoPilot displays it on 
top of all other windows.  CoPilot's text-to-speech engine will speak the itinerary update 
when it is received. 

You have the option to use the four Standard Response Buttons  (see p. 56).

You can also Accept or Decline the change to your trip itinerary.   If you accept, CoPilot 
Live will automatically start giving route guidance from your current location using the new 
itinerary.
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CoPilot Live Real-time Traffic Reporting
NOTE: Traffic is an optional additional-cost service and is not available in all areas.

In addition to providing pre-trip planning, GPS route guidance, and Live messaging 
capabilities, CoPilot Truck uses wireless Live communications to automatically send real-
time information to drivers, notifying them of traffic incidents along the route ahead and 
creating potential alternate routing.  In Guidance Mode, CoPilot Live can provide you with 
regularly updated traffic incident reports and alternate routes based on your destination and 
route ahead.   (Note that CoPilot must have GPS acquisition, a user-inputted destination, and 
Internet access in order to provide real-time traffic information.)

There are two ways to receive real-time traffic feeds with CoPilot Live:

1.  Use a wireless Internet (GPRS) connection to receive traffic incidents through 
a traffic service provider.

2.  Use a TMC-enabled traffic receiver to obtain traffic incidents through a 
dedicated FM band.

Getting Live Traffic Data in Guidance Mode
Begin by launching CoPilot Truck on your laptop.  CoPilot must have GPS acquisition, a 
user-inputted destination, and a traffic feed (GPRS or TMC).  In Guidance mode, click the 
Live button, check Enable Live Network and check Enable Traffic to turn traffic reporting 
on.  Use the Traffic buttons to check, review, and edit your alerts and to change settings as 
described on p. 62-63.
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Check Traffic
Click the Check Traffic button to see all traffic incidents on the route ahead between 
your current position and your destination.  CoPilot will take a few seconds to check for 
incidents.  If any incidents are found, they are reported one by one beginning with the one 
closest to you.  You will see them on the map (see p. 61) and can decide whether you want 
CoPilot to continue along the current route or to generate an alternate route around the 
reported congestion (you’ll be able to accept or reject the alternate route).  
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If you want CoPilot to generate an alternate route 
around an incident, click the Avoid button. If you 
wish to ignore the incident, click one of the two 
arrows.  The forward arrow takes you to the next 
incident (if there is one) and the back arrow takes 
you to the previous incident (if there is one).

If you do not respond to a message, it will be 
automatically hidden after the amount of time you 
set in the Live Options window (p. 54) — or after 
30 seconds by default.  When that happens, CoPilot 
will either ignore or route around the incident based 
on how you have set your options — see Traffic 
Settings, p. 60.



Review and Clear Traffic
The Check Traffic button in the Live Options window brings up only new incidents along 
your route that have not been reported yet.  To review the traffic incidents that were already 
reported, click the Review Traffic button.  To clear the traffic incident queue so that Check 
Traffic brings up every incident, click Clear Traffic.

Traffic Settings
Click Settings in the Traffic section of the Live Options window to set additional options 
that tell CoPilot how to handle incident reporting.

The Speak new incidents check box controls whether CoPilot speaks each incident message 
out loud when it appears.  Check Automatically check for new incidents if you want to 
be notified about congestion without having to manually check it yourself.  Choose a time 
interval for automatic reporting from the pick list.

When CoPilot hides an incident alert that did not receive a response, by default that incident 
will be ignored.  If you would like CoPilot to automatically generate an alternate route for 
each alert you do not respond to, choose Avoid from the Default incident action pick list. 

Click Go to save your settings.
   

- 60 -



- 61 -

Map Display of Incidents
Traffic incidents are represented on CoPilot Live’s maps by the triangular icons shown 
below.  These icons reflect the location(s) and type of traffic congestion ahead on your 
route.

General Incident

Accident

Road Construction

Weather

Traffic Jam
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Creating/Using Your Own Voice
You can create your own voice or load voices that other CoPilot users have created and 
posted online.  To do this, create a folder with any name you want and copy sound files with 
the exact names of the CoPilot sound files.

The CoPilot sound file names and their associate dialogs are: 

File Name     Dialogue

100y.wav           One Hundred Yards Ahead
150y.wav           One Hundred Fifty Yards Ahead
1kmWarning         1 Kilometer Ahead
1miWarning         1 Mile Ahead
200mWarning        200 Meters Ahead
200y.wav           Two Hundred Yards Ahead
250y.wav           Two Hundred Fifty Yards Ahead
2kmWarning         2 Kilometers Ahead
2miWarning         2 Miles Ahead
300y.wav           Three Hundred Yards Ahead
350y.wav           Three Hundred Fifty Yards Ahead
3tenthmiWarning    3/10ths of a Mile Ahead
400y.wav          Four Hundred Yards Ahead
450y.wav           Four Hundred Fifty Yards Ahead
500mWarning        500 Meters Ahead
500y.wav           Five Hundred Yards Ahead
50y.wav            Fifty Yards Ahead
Arrived            Approaching Stop
BearLeft           Bear Left
BearRight          Bear Right
CancelDetour       Cancelling Detour
CPWelcome          Welcome to CoPilot
Detour             Finding Detour
Fspcam.wav         Attention Fixed Automatic Safety Camera
Junction.wav       Take Motorway Junction
JustAhead          Just Ahead
Keepleft.wav       Keep Left
Keepright.wav      Keep Right
Keeps.wav         Keep Straight Ahead
LeftTurn           Turn Left
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NextStop           Continuing to Next Stop
PoiAhead           Point of Interest Ahead
Rdestination.wav   You Have Reached Your Destination
RightTurn          Turn Right
Roundabout1        Take 1st Exit at Roundabout
Roundabout10       Take 10th Exit at Roundabout
Roundabout2        Take 2nd Exit at Roundabout
Roundabout3        Take 3rd Exit at Roundabout
Roundabout4        Take 4th Exit at Roundabout
Roundabout5        Take 5th Exit at Roundabout
Roundabout5        Take 6th Exit at Roundabout
Roundabout7        Take 7th Exit at Roundabout
Roundabout8        Take 8th Exit at Roundabout
Roundabout9        Take 9th Exit at Roundabout
SafetyCam          Safety Camera Ahead
SharpLeft          Make a Sharp Left
SharpRight         Make a Sharp Right
Spcam.wav         Speed Camera Ahead
TakeExit           Take Exit
Then              Then
TrafficWarning     Traffic Incident Reported
TurnAround         Turn Around
Waypoint           Approaching Stop

NOTE:  The sound files must be saved in OGG or WAV format.  

EXAMPLE: 

-  Create a folder—the name of the folder can be anything you want 
(for this example we’ll use ‘Fun Voice’ as the folder name).

-   Record sound files to replace some or all of the CoPilot sound files 
(CoPilot will use the default voice for sound files it does not find).

-   Copy the folder with the new sound files to Storage Card\CoPilot\Save\[Choose a 
language folder].

-   Now when you select that language, you’ll see ‘Fun Voice’ as one of the 
voice options (see page 32 for details on changing your voice).



Trouble-shooting
First things to check: Are all cables properly secured?  Do all components have adequate 
power?  Does your GPS receiver have a clear view of the sky?  (Buildings, mountains and 
heavy foliage may block your satellite reception.)

Why can't I get a satellite fix the first time I use CoPilot?
The first time the GPS receiver is used it can take approximately 15 minutes to acquire a 
signal.  This should not be the case with subsequent uses.  

Why does it take so long to find the satellites?

When the GPS unit is first initialized it can take several minutes for the receiver to locate 
the satellites in orbit.  Be sure that the GPS receiver has an unobstructed view of the sky.  

What do I do if the computer will not recognize my voice commands?
For CoPilot to listen and respond, the Listening button must be toggled on in the lower right 
corner of the Guidance screen.  Background noise may affect CoPilot's ability to recognize 
spoken commands.  You can use an external microphone with noise-cancellation technology 
to optimize your experience with CoPilot's listening device.

  Listening On   Listening Off

What do I do if I can’t hear CoPilot speaking?
To hear CoPilot speak to you, the Speaking button must be toggled on in the lower right 
corner of the Guidance screen.

  Speech On   Speech Off

Most laptops come equipped with a sound card and built-in speakers.  You can adjust the 
volume output from your laptop by using the Volume Control panel that comes with your 
system.  Frequently, however, the small speakers on a laptop won't produce sufficient 
volume to be heard in a moving automobile.  To amplify the output, you can plug something 
into the speaker jack, such as additional speakers.  
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Another alternative is to purchase an audio cassette adapter equipped with a cord and jack 
that you can plug into your laptop's speaker jack, then put the cassette into your car's stereo 
cassette player.  This will channel CoPilot's commands through your car's stereo system if 
it's set to play audio tapes.  
NOTE:  Please don't drive with headphones on because this is unsafe!

When I try to run CoPilot I get a message that says “CoPilot Can't Find the Data 
Disc”, and the program won't start. What can I do?

1.  Is the Data Disc in the CD-ROM drive? 

A. If yes, see question 2 below. 

B. If no, place the Data Disc in your CD-ROM drive and try using CoPilot again. If 
you are still having trouble once the Data Disc is in your CD-ROM drive, see question 
2 below. 

2.  Is the underside (the side without artwork) of the Data Disc clean? 

A. If yes, see question 3 below. 

B. If no (you see lint or finger prints), you can clean the CD by using a soft, clean piece 
of lint free material slightly moistened with water.  Place the Data Disc in the CD-ROM 
drive once it is dry and try using your CoPilot program again. 
If you're still having trouble, see question 3 below. 

3.  Is CoPilot looking at the right drive when trying to read the Data Disc?  To check, please 
follow the instructions listed below:

A. First, we need to determine the drive letter of your CD-ROM drive.  (If you already 
know your drive letter, move to step B on the next page.) 

To do this: 

1. Go to your Start button/Programs/Windows Explorer.  In the upper left hand 
corner of your screen, you'll see a white box (it may have a drive displayed in it) 
with a black arrow just to the right of the white box. 

2. Click once on the black arrow so that all of your drives are shown.  Your CD-
ROM drive is the one that has the CD-ROM icon next to it.  And next to the 
CD-ROM icon, there should be a letter - this is your CD-ROM drive letter. 
Please remember it and move to section B. 



B. Next, you need to check that CoPilot is looking to this drive to locate the Data Disc. 
In the example below, your CD-ROM is the D drive.  Your drive letter may be different.

To do this: 
1. Go to your Start button/Programs/Windows Explorer and click on the drive 

letter which corresponds to your hard drive (usually C). 

2. Within drive C, find the folder Program Files and double-click on it so that 

 all of your program folders are listed. 

3.  Find the "CoPilot Live" folder and double-click on it. 

4.  Find the “Laptop” folder and double-click on it. 

5.  Find the folder APP and double-click on it 

6.  You'll see a file named "data.cfg" listed among other folders. Double-click on 
the data.cfg file--Windows will open a new window and prompt you to select 
a program to open the file with. Scroll down the list of programs and select 
Notepad.

7.  The second line of the file should read: "LRGridDir"="D:\Data". Make sure 
the letter between "=" and ":" is your CD-ROM drive letter. If the drive letter is 
incorrect, change it to the correct letter. Go to file and click on SAVE AS, and 
then click Save, and then click on Yes to save over existing file. 

8.  Close Windows Explorer and run CoPilot normally.

CoPilot keeps saying "No GPS signal. Please check the power connections".  
What should I do?

This indicates that CoPilot is not getting GPS data from the antenna/receiver either because 
the GPS unit is not getting power, or because the GPS data is not getting from the antenna/ 
receiver into your laptop. 

1. Is the GPS unit getting power?

A. If you are powering the GPS unit through your car's cigarette lighter, you car needs 
to be turned on and the adapter needs to fit snugly into the cigarette lighter. 

B. If you are powering the GPS unit through your laptop's PS/2 port, make sure the 
connection is snug and that your laptop's battery has enough power.  If you've checked 
the power supply, and it is sufficient, see question 2.
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2.  Is the GPS unit plugged into the serial or USB port?

A. The serial port is a 9-pin port usually on the back of your laptop.  One end of the 
GPS unit cord should have a 9-pin head that should plug easily into your serial port.  If 
you've checked the port connection, see question 3. 

3.  Are the port settings correct for the Com port? 
NOTE: CoPilot uses Com 1 as the default Com port. Some computers may have more 
than one Com port.  You will need to test each Com port starting with Com 1.

A. Click on the Start button, Settings, Control Panel. 

B. Double-click on the System icon. 

C. Click on the Device Manager tab. 

D. Click on the "+" sign next to Ports. 

E. Click on Com 1 so it's highlighted and click on the Properties button below. 

F. Under the General tab in Device Manager make sure it says this device is working 
properly under Device Status.  Next, under Device Usage make sure there is no check 
mark in the box Disable in this hardware profile.

G. Click on the Port Settings tab. The settings should read as follows
--  Bits Per Second = 4800
--  Data Bits = 8 
--  Parity = None 
--  Stop Bits = 1 
--  Flow Control = Hardware
If the settings are different you need to make the necessary changes, then click 
OK and restart your computer.   

4.  Are you using the correct Com port for the GPS unit?  

To check which Com port to use with the GPS unit follow the directions below:

A. Go to your Start button/Programs/Accessories/Communications/Hyperterminal 

B. Double-click on the file Hyperterm.exe to open the program.

C. Enter a name (any name) and click OK. 

D. Next at the bottom where it says Connect using select direct to Com 1 and click 
OK.



E. Next in the Com Port Properties window the settings should read: 
--  Bits Per Second = 4800
--  Data Bits = 8
-- Parity = None 
--  Stop Bits = 1 
--  Flow Control = Hardware 
If the settings are different you need to make the necessary changes and then click 
OK. If the GPS unit has power and is able to connect, you will see information flowing 
across the screen (random letter and numbers).  If you do not see any information 
flowing across the screen, go back to step E above and repeat those same steps, trying 
other Com ports (2,3,4) until you find the correct one. 

F. Once you have found the right Com port (1,2,3, etc.), please do the following: 

1. Open CoPilot.

2. Go to the GPS menu and click on the Status tab. 

3. Make sure that the Com port number is the same one you found above (1,2,3, etc.) 
in the Hyperterminal.  If it is different use the drop down menu to change the Com 
port and click the Close button.  Next exit the program to accept the changes. You 
should now be able to use CoPilot normally.

4. If you have a Palm Pilot, you need to close Hot Sync. NOTE: Hot Sync manager 
may be in your Start up folder causing the Hot Sync manager to enable each time 
you start your computer.  If you do not wish to manually disable the Hot Sync 
manager each time you will need to delete it from the Start menu:

a. To disable the Hot Sync manager click on My Computer. 

b. Click on your C: Drive or the drive Windows is installed to. 

c. Click on the Windows folder. 

d. Click on the Start Menu folder. (If no folders appear click on Show Files.) 

e. Click on the Programs folder. 

f. Click on the StartUp folder. 

g. Now highlight the Hot Sync icon and delete it from the StartUp folder. 
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Data Corrections
The ALK map database undergoes constant revision as we strive to provide you with the high-
est quality product. Revisions include the addition of new roads, roadway upgrades, and the 
addition of new streets and addresses. If you encounter missing or inaccurate map data, please 
contact us so that we can include it in our updates.

The single best way to convey data corrections is through the submission of your GPS tracks 
— every time CoPilot is on it records a GPS track that contains position information that ALK 
uses to realign existing roads, fi x one-way designations and add new roads.

To submit GPS tracks from within CoPilot:

1. Make sure you have Internet access from your desktop.
2. Open CoPilot on your desktop.
3. From the top toolbar select GPS > Submit GPS Tracks.
4. CoPilot pulls the GPS tracks from your computer and sends them to ALK electronically.

To submit GPS tracks by E-mail:
On your laptop your GPS tracks (fi les that end with .gps) are stored in your C:\Program Files\
CoPilot\Laptop8\GPSTrack folder.  Simply attach them to an email and send the email to 
data@alk.com.

Using the Data Corrections Form To Add Comments/Suggestions:
You can use our built-in Data Corrections form to supplement any GPS tracks you submit. This 
form has space to make notes regarding specifi c problems with map data.

1. Make sure your desktop is connected to the Internet
2. Open CoPilot on your desktop
3. From the top toolbar select Help > E-mail Data Corrections
4. Complete the form and click Send

Contact ALK by Mail/Fax:
You also have the option to write out any data corrections and/or create a CD with GPS tracks 
and mail/fax them to:

ALK Technologies
Attn: Data Corrections
1000 Herrontown Road · Princeton, NJ · 08540  USA
Fax: 609-252-8166 (North America only)
E-mail: data@alk.com or choose E-mail Data Corrections from the CoPilot Help menu
  in Planning Mode (North America only)
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Using the CoPilot Help Files
In Planning Mode, CoPilot provides extensive built-in Help to guide you through the 
program.  Click on the Help button in a window to open a Help topic that describes how 
to use that window.  For example, if you’re entering a stop in the Trip Planner window, 
the Help button will open to a topic that describes the Trip Planner window.  From there, 
you can navigate through other topics, use the Help Index, or do a search using the Search 
feature.

Another way to access the Help files is through the Help menu.  Contents and Search will 
display the main topics available and allow you to enter a search using the Search dialog 
box.  How to Use Help provides Microsoft instructions about using Help files.

You also have the option of activating “bubble help” which automatically provides brief 
hints as you pass the cursor over certain areas.  In the Tools menu, select Options and check 
Show hints in the Interface tab of the Options dialog box.

Technical Support
After registering your software, you're entitled to technical support and discounts on future 
updates.  Check out ALK’s web site for technical support documentation and posted answers 
to common questions.  If the web site does not provide an answer to your question, technical 
support for registered users is available during standard business hours (9:00 am-5:00pm 
Monday-Friday).  You should be at your computer and have your Installation Product Key 
available when you contact us (your Installation Product Key can be found on the front 
cover of the printed Quick Start that came with the product).  

Please be sure to reach us using the contact information for your region shown below.  
We are sorry, but our support staff in ALK’s regional offices cannot respond to requests for 
assistance outside the areas they serve. 

North America - Web: www.alk.com, E-mail: cpsupport@alk.com, Fax: 609-252-8166, 
Phone: 888-872-8768

Europe - Web: www.alk.eu.com, E-mail: ukcustservice@alk.eu.com, 
Postal: Suite 8, 4 Bloomsbury Square, London WC1A 2RP, UK
Phone: +44 (0)207 404 4222

Australia - (Travroute Australia Pty. Ltd.) Web: www.travroute.com.au, 
E-mail: support@travroute.com.au, Phone: 03-9855-1498
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Appendix A:  PC*MILER Route Types & Options
The industry-standard PC*MILER route types and options described below are included with 
CoPilot Truck.

PC*MILER Practical Routing
Practical Routes represent distances and driving routes that a driver would normally take to 
minimize time and cost. Practical Routes model the trade-off between taking the most direct path 
and staying on major, high quality highways.  Interstate highways are given a higher priority than 
toll roads, which in turn are given a higher priority than secondary highways, and so on.  Routing 
instructions and mileages can be used when actual travel distances and directions are needed.

Practical routings consider distance, road quality, terrain, urban/rural classifications, truck-
restricted roads, and designated principal and secondary through routes.

PC*MILER Shortest Routing
Shortest Routes represent distances and driving routes that a vehicle would take to minimize total 
distance traveled while still following a reasonable route.  For instance, Shortest Route mileages 
and routes will also avoid truck-restricted roads and, in some cases, may favor a beltway rather 
than traveling directly through a city. 

PC*MILER National Network Routes
The National Network is a government-designated system of highways originally established 
by the Surface Transportation Assistance Act of 1982.  This routing option is based on the 
federally-designated National Network system updated  in the April, 1992 Code of Federal 
Regulations, Part 658, Appendix A.  The National Network includes the Interstate System 
(several minor segments are not included), and many selected US and state highways.  Highways 
continue to be added to the National Network by federal and state governments.

PC*MILER National Network routing represents distances and driving routes which are most 
reasonable and legal for the larger trucks authorized by the Surface Transportation Assistance Act 
of 1982.

National Network routing stays on the National Network to the maximum extent possible.  
Given that many areas are not directly served by the National Network, the origin and stop-offs 
of your route may not be on the National Network.  In these cases PC*MILER routing takes the 
shortest reasonable path from the origin and stop-offs to the Network.  Driving directions for 
PC*MILER National Network routes provide a warning wherever the route is forced to use a 
non-conforming link.  These road segments should be checked before traveling.
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National Network mileages tend to be higher than Shortest or Practical mileages.

These designated highways permit, at a minimum, 102” wide, single 48 ft. trailers and tandem 
28 ft. trailers.  The Interstate system and most, but not all, remaining designated routes are open 
to 80,000 pound vehicles.  Certain states, notably Arkansas and Mississippi, have designated 
certain National Network segments with less than an 80,000 pound capacity.

In addition to the National Network highways, access routes and access policies are components 
of routing STAA dimensioned trucks.  The Federal government has mandated that no state may 
prohibit travel from the National Network for a minimum of one road mile unless safety 
restrictions apply.  Additionally, no state may deny reasonable access to terminals and facilities 
for food, fuel, repairs and rest.

Several states maintain more generous access policies and lists of specifically designated access 
routes to 
terminals and facilities.  Should you need to travel beyond the National Network and beyond the 
access roads, you must acquire the proper permit.

NOTE:  These suggested National Network routings are based on official highway maps, the 
Code of Federal Regulations, and information provided by state governments.  It is provided 
without a warranty of any kind.  The user assumes full responsibility for any delay, expense, 
loss, or damage which may occur as a result of its use.

PC*MILER 53 Foot Trailer Routing
Because every mile equals money, PC*MILER offers enhanced routing specifically for 53’ 
trailers.  The calculations for these routes are based on National Network routing, with the 
addition of roads that permit 53’ trailers.  Driving directions for PC*MILER 53’ Trailer routes 
now provide a warning wherever the route is forced to use a non-conforming link.

PC*MILER Toll Discouraged Routing

For carriers who desire to avoid long stretches of toll roads, a Toll Discouraged routing option is 
provided.  Toll Discouraged routing will avoid long stretches of toll roads but will not take long, 
impractical detours to avoid toll bridges and tunnels.  For example, a routing from Boston, MA 
to Albany, NY will avoid the Massachusetts Turnpike, but a routing from Camden, NJ to 
Philadelphia, PA will include a toll bridge.
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PC*MILER Heavy/Light Vehicle Routing
In addition to the five basic route types, the Heavy and Light Vehicle routing option is also a 
critical setting.  (A “heavy vehicle” is one weighing at least 80,000 pounds; a “light vehicle” 
weighs less than 80,000 pounds.)

The Override Restrictions routing option controls this setting (Guidance Mode > Options > 
Routing).  When checked, Light Vehicle routing is in effect.  PC*MILER routing always avoids 
truck-prohibited roads, but Light Vehicle routing allows truck-restricted roads to be considered 
for a route.  (Preference is normally given to Interstates, major highways, and major thru-roads 
where possible.)  With Heavy Vehicle routing in effect, both truck-prohibited and truck-restricted 
roads will always be avoided.  In addition, Heavy Vehicle routing takes nationwide 13' 6" height 
restrictions into account.  

This setting affects which roads trigger a truck restriction warning on your screen.  

When Light Vehicle routing is in effect, the Truck Restrictions indicator in the upper right corner 
of the guidance screen will be gray.

PC*MILER Hazardous Material Routing
PC*MILER hazardous materials routing calculates routes based on over thirty different hazmat 
road categories.  Hazmat route types include General, Caustic, Explosives, Flammable, Inhalants, 
and Radioactive.  

For a detailed description of how each hazmat routing type handles hazmat road categories, see 
the CoPilot Truck Help files.  To access Help, in Planning Mode select Help menu > Help 
Contents and Search.
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CoPilot® End-User License Agreement 
NOTE: On the following pages there are three separate license agreements for users of North 
American, European, and Australian Data.

THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE USER (either an individual or an entity),  
AND ALK TECHNOLOGIES, INC. ("ALK").  IF YOU DO NOT AGREE TO THE TERMS OF 
THIS License, DO NOT OPEN THE PACKAGE.  Promptly return the unopened CD-ROM package 
and accompanying materials (including written materials and containers) to the dealer from which you 
obtained them for a full refund. 

OPENING THE PACKAGE OR USING THE ENCLOSED SOFTWARE INDICATES YOUR 
ACCEPTANCE OF THE TERMS OF THIS License.

ALK® Technologies, Inc. LICENSE AGREEMENT
CoPilot | Pocket PC 6 with NORTH AMERICAN DATA
LICENSES: 1 User

1. Grant of License:

This ALK License Agreement ("License") is a single-user, non-exclusive, non-
transferable license agreement and not an agreement for sale. ALK hereby 
licenses the Help Files and CD-ROM software identified above (collectively, 
"the Software") to you under the following terms and conditions.

The Software may not be loaded onto a network of any type.  You may use the Software on any 
compatible personal computer, provided you use it on only one computer at a time.  The Software 
is "in use" on a computer when it is loaded into the temporary memory (i.e., RAM) or installed into 
the permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that computer.  You 
may make a single back-up or archival copy of the Software for back-up purposes only.  You may not 
transfer this Software or assign this License Agreement to another party.  

You are not permitted to, during the term of this License Agreement and thereafter:

• Use the Software on a network or file server.
• Use or copy the Software or the accompanying documentation except as provided in this License 

Agreement.
• Alter, merge, modify, or adapt the Software or the accompanying documentation in any way 

including disassembling or decompiling this Software.
• Loan, lease, sell, transfer, or sublicense the Software or the accompanying documentation.
• Copy, loan, lease, sell, transfer, or sublicense any output of this Software (including but not limited 

to printed maps and  driving itineraries); However, you may provide a limited number of printed 
copies of a single trip to family members or traveling companions.

•  You are not permitted to use the Software for motor-carrier tariff or routing purposes.
• Electronic reproduction and transmission of output to remote locations is not permitted.
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ALK retains all rights not expressly granted.  Nothing in this License Agreement constitutes a waiver 
of ALK's rights under the U.S. copyright laws or other applicable copyright laws or any other federal 
or state law.

2. Term:

This License is effective upon receipt by you of the Software and upon opening the package.  The 
License is effective until terminated.  You may terminate this License at any time by returning all 
copies of the Software, and any portions thereof, to ALK.  The License terminates automatically if you 
fail to comply with any of the terms of this License Agreement.  You agree upon such termination to 
return or destroy this CD-ROM and all other copies of the Software and certify in writing to ALK that 
you have done so..

3. Limited Warranty:

ALK warrants that all disc(s) on which the Software is furnished shall, for a period of 90 days from 
delivery (the "Warranty Period") be free, in normal use, from defects in material and workmanship.  
ALK will have no responsibility to replace any disc(s) that have been damaged by accident, abuse, or 
misapplication.  

Customer Remedies: ALK's entire liability and your exclusive remedy shall be, at ALK's option, 
either (a) return of the price paid or (b) replacement of the disc(s) that does not meet ALK's Limited 
Warranty, and that is returned to ALK with a copy of your receipt.

Except as specifically provided above, ALK MAKES NO OTHER WARRANTY OR 
REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE 
OR DOCUMENTATION, INCLUDING ANY WARRANTY AS TO THE QUALITY, 
PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.  IN NO 
EVENT WILL ALK TECHNOLOGIES, INC. BE LIABLE FOR DIRECT DAMAGES IN EXCESS 
OF THE License FEE OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR 
DOCUMENTATION, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO 
CASE SHALL ALK'S LIABILITY EXCEED THE AMOUNT OF THE License FEE.

While the information contained in the Software was believed to have been correct at the time of 
publication, ALK cannot guarantee its accuracy and shall not be subject to liability for any errors or 
omissions.  Information in the Software and its accompanying preprinted materials is subject to change 
without notice and does not represent a commitment or endorsement on the part of ALK.  Routes and 
miles generated by the Software are not suitable for commercial truck use.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND 
IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED.  No ALK dealer, 
distributor, agent, or employee is authorized to make any modification or addition to this warranty.  
Some states do not allow the exclusion or limitation of implied warranties or limitation of liability for 
incidental or consequential damages, so the above limitation or exclusion may not apply to you.

4. Licensee's Responsibility:

You assume all responsibility for, and ALK shall not be liable for, all action taken, decisions made, and 
advice given as a result of your use of the Software.
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5. US Government Restricted Rights:

The Software and documentation are provided with restricted and limited rights.  Use, duplication, 
or disclosure by the Government is subject to restrictions set forth in subparagraphs (c) (1) and (2) 
of the Commercial Computer Software-Restricted Rights clause at 48 CFR 52.227-19, as applicable.  
Manufacturer is ALK Technologies, Inc., 1000 Herrontown Road, Princeton, NJ 08540.

6. General:

The export or re-export of the Software may be restricted by the laws of the United States and other 
countries, and you shall not export this Software in violation of any such applicable laws.  This 
License Agreement is governed by the laws of the State of New Jersey. 

© Copyright 1990-2006 ALK Technologies, Inc.

--------------------------------------------------------------------------
Exit Authority (c) 1999-2006 Zenrin USA, Inc.  All rights reserved.
--------------------------------------------------------------------------
Disclosure for products containing Canadian Postal Code and/or Canadian Street-Level Data: 
Based on Computer File(s) licensed from Statistics Canada. © Copyright, HER MAJESTY THE 
QUEEN IN RIGHT OF CANADA, as represented by the Minister of Industry, Statistics Canada 
2006.   ALK Technologies, Inc. is an Authorized User of selected Statistics Canada Computer File(s) 
and Distributor of derived Information Products under Licensing Agreement 6147.  No confidential 
information about an individual, family, household, organisation or business has been obtained from 
Statistics Canada. 

--------------------------------------------------------------------------

Software License Agreement for FONIX TEXT TO SPEECH ENGINE

IMPORTANT! READ THIS License AGREEMENT BEFORE OPENING THIS SOFTWARE 
PACKET.  BY OPENING THE SEALED PACKET OR USING THE SOFTWARE, YOU INDICATE 
YOUR ACCEPTANCE OF THE ENTIRE AGREEMENT.

SOFTWARE License AGREEMENT

This Agreement is a legal agreement between you and Fonix Corporation ("Fonix"), but may be 
superseded by a separate license agreement that you and Fonix have signed.  The software in this 
packet ("Software") and its media and documentation (collectively, the "Product") are protected by 
copyright and other intellectual property laws and international treaties.  You have no title to, or 
ownership of, the Product, other than its physical media.  Fonix reserves all rights not specifically 
granted in this Agreement.

USE AND RESTRICTIONS: You may operate the Software on only one computer.  However, if you 
have purchased a network or multiple-user license, you may load and use as many single-use copies 
and/or support as many concurrent users, in the aggregate, as are authorized by such license.  You may 
make only one copy of the Software, retaining the Fonix CD or other media for storage and back-up 
purposes.  The Software does not include updates, maintenance, or support, which may be separately 
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available.  This Software and its voice output are for your personal, individual use only.  You are 
not permitted to broadcast or distribute the voice output of the Software (i.e., synthesized speech) to 
more than one person or to use the Software's voice output for any commercial purposes.  You may 
not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network, or create derivative 
works based on any part of the Software.  You may not reverse engineer, decompile, or disassemble 
the Software.

LIMITED WARRANTY: Fonix warrants that the Product's physical media will be, under normal 
use, free from defects in material and workmanship for one year from the date you purchased it.  
Fonix's entire liability, and your exclusive remedy under this warranty, will be replacement of the 
defective media without charge.  EXCEPT FOR THIS LIMITED WARRANTY, FONIX MAKES NO 
WARRANTIES, EXPRESS OR IMPLIED, AND DISCLAIMS ANY IMPLIED WARRANTY OR 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Fonix does not warrant that 
the product is entirely error-free.  FONIX'S TOTAL LIABILITY FOR ANY CLAIM OR DAMAGE 
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE SHALL BE LIMITED 
TO DIRECT DAMAGES, WHICH SHALL NOT EXCEED THE License FEE YOU PAID.  IN NO 
EVENT SHALL FONIX BE LIABLE FOR LOST PROFITS, LOST DATA, INTERRUPTIONS OF 
BUSINESS, OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OF OR INABILITY TO USE THE SOFTWARE, REGARDLESS OF WHETHER FONIX HAS 
NOTICE OF THE POTENTIAL FOR SUCH LOSS OR DAMAGE.

The above limitations may be superseded by law in some jurisdictions.

U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and any accompanying materials 
are provided with Restricted Rights.  Use, duplications, or disclosure by the Government is subject 
to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software-Restricted Rights at 48 CFR 52.227-19, as applicable.  Contractor/manufacturer is Fonix 
Corporation at 1225 Eagle Gate Tower, 60 East South Temple St., Salt Lake City, Utah 84111.

ALK® Technologies, Inc. License AGREEMENT
CoPilot | Pocket PC 6 with EUROPEAN DATA
LICENSES: 1 User

IMPORTANT: Please read the following agreement ("License") carefully. 

THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE USER (either an individual or an entity), 
AND ALK Technologies, Inc. ("ALK").  IF YOU DO NOT AGREE TO THE TERMS OF THIS 
License, DO NOT INSTALL THE SOFTWARE.  Promptly return the package and accompanying 
materials (including written materials and containers) to the dealer from which you obtained them for a 
full refund.

Acceptance:  Installation or use of the enclosed ALK Technologies, Inc. ("ALK") software (the 
"Software") on your computer constitutes your acceptance of these terms. If you do not agree to the 



- 78 -

terms of this License, you must immediately delete the Software from your computer and destroy any 
copies you made of the Software and of any written materials relating to the software, and promptly 
return the Software and, if bought as part of a package, any associated devices to your retailer for a 
refund.

License:  ALK grants you, as an individual, a License to install and use one copy of the Software on 
a single personal computer at a time. Your License to use the Software is subject to you complying 
with the terms of this License.   A License is required for each installation of the Software, unless the 
Software is (i) installed temporarily on a computer during the repair or maintenance of the computer 
on which the Software is normally installed and (ii) is immediately deleted from such computer as 
soon as those repairs or maintenance are complete.  You may make one copy of the Software for 
backup purposes only. 

Copyright: United States copyright law and international treaty provisions protect the Software. 
You agree that no title to the intellectual property in the Software is transferred to you. You further 
acknowledge that title and ownership rights will remain the exclusive property of ALK, and you will 
not acquire any rights to the Software except as expressly set out in this License.  You agree that any 
copies of the Software will contain the same proprietary notices that appear on and in the Software. 

Prohibited Use: Unless you have ALK's prior written permission, you may not (i) use, copy, modify, 
alter, or transfer the Software or accompanying documentation, except as expressly permitted in 
this License; (ii) translate, disassemble, decompile, or reverse engineer the Software (iii) sublicense 
or lease the Software or its documentation; or (iv) use the Software in a multi-user or networked 
environment or on a rental basis or in a time-sharing or computer service business.  

Limited Warranty: ALK warrants that the Software will perform substantially in accordance with 
the accompanying written materials for a period of 30 days from the date of purchase.  Any implied 
warranties relating to the Software are limited to such 30 day period provided that limitation is 
permitted by applicable law. 

End-User Remedies: If the Software does not conform to the "Limited Warranty" above, ALK's 
entire liability and your sole and exclusive remedy will be, at ALK's option, either to (i) correct the 
error, or (ii) help you work around the error, or (iii) accept a return and issue a refund through your 
retailer. The Limited Warranty is void if failure of the Software has resulted from your fault, abuse, 
or misapplication.  If we correct an error in the Software for you, then the unexpired portion of 
the Limited Warranty period as at the date you informed us of the error will apply to the corrected 
software once you have received the corrected version.

NO OTHER WARRANTIES: EXCEPT AS SET OUT IN THE LIMITED WARRANTY, ALK DOES 
NOT WARRANT THAT THE SOFTWARE IS ERROR FREE.  ALK DISCLAIMS ALL OTHER 
WARRANTIES WITH RESPECT TO THE SOFTWARE, WHETHER EXPRESS OR IMPLIED, 
INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF THIRD PARTY 
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RIGHTS.  Some jurisdictions do not allow the exclusion of implied warranties or limits on how long 
an implied warranty may last, or an exclusion of incidental damages.  This means the above limitations 
or exclusions may not apply to you.  This warranty gives you specific legal rights and you may also 
have other rights depending on your country. 

No Liability for indirect loss: In no event will ALK be liable to you for any loss of profit, wasted 
time, lost business or for any incidental, or indirect loss of any kind arising out of the performance or 
use of the Software, even if ALK has been advised of the possibility of such damages. 

Termination:  Without prejudice to its other rights, ALK may terminate this License if you fail to 
comply with these terms and conditions. In that situation, you must destroy all copies of the Software.

Choice of Law:  This License is governed by the laws of England.

-----------------------------------------------------------------------------
End User License Agreement for NAVTEQ European Data
For Portable Navigation Device Applications

The data (“Data”) is provided for your personal, internal use only and not for resale.  It is 
protected by copyright, and is subject to the following terms and conditions which are agreed to 
by you, on the one hand, and ALK Technologies Inc. (“ALK”) and its licensors (including their 
licensors and suppliers) on the other hand.

© 2006 NAVTEQ.  All rights reserved.

TERMS AND CONDITIONS

Personal Use Only.  You agree to use this Data together with COPILOT® LIVE for the solely 
personal, non-commercial purposes for which you were licensed, and not for service bureau, time-
sharing or other similar purposes.  Accordingly, but subject to the restrictions set forth in the following 
paragraphs, you may copy this Data only as necessary for your personal use to (i) view it, and (ii) 
save it, provided that you do not remove any copyright notices that appear and do not modify the Data 
in any way.  You agree not to otherwise reproduce, copy, modify, decompile, disassemble or reverse 
engineer any portion of this Data, and may not transfer or distribute it in any form, for any purpose, 
except to the extent permitted by mandatory laws.

Restrictions.  Except where you have been specifically licensed to do so by ALK, and without limiting 
the preceding paragraph, you may not (a) use this Data with any products, systems, or applications 
installed or otherwise connected to or in communication with vehicles, capable of vehicle navigation, 
positioning, dispatch, real time route guidance, fleet management or similar applications; or (b) with 
or in communication with any positioning devices or any mobile or wireless-connected electronic or 
computer devices, including without limitation cellular phones, palmtop and handheld computers, 
pagers, and personal digital assistants or PDAs.
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Warning. The Data may contain inaccurate or incomplete information due to the passage of time, 
changing circumstances, sources used and the nature of collecting comprehensive geographic data, any 
of which may lead to incorrect results.

No Warranty.  This Data is provided to you “as is,” and you agree to use it at your own risk.  ALK 
and its licensors (and their licensors and suppliers) make no guarantees, representations or warranties 
of any kind, express or implied, arising by law or otherwise, including but not limited to, content, 
quality, accuracy, completeness, effectiveness, reliability, fitness for a particular purpose, usefulness, 
use or results to be obtained from this Data, or that the Data or server will be uninterrupted or error-
free.

Disclaimer of Warranty: ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS 
AND SUPPLIERS) DISCLAIM ANY WARRANTIES, EXPRESS OR IMPLIED, OF QUALITY, 
PERFORMANCE, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-
INFRINGEMENT.  Some States, Territories and Countries do not allow certain warranty exclusions, 
so to that extent the above exclusion may not apply to you.

Disclaimer of Liability:  ALK AND ITS LICENSORS (INCLUDING THEIR LICENSORS AND 
SUPPLIERS) SHALL NOT BE LIABLE TO YOU: IN RESPECT OF ANY CLAIM, DEMAND OR 
ACTION, IRRESPECTIVE OF THE NATURE OF THE CAUSE OF THE CLAIM, DEMAND OR 
ACTION ALLEGING ANY LOSS, INJURY OR DAMAGES, DIRECT OR INDIRECT, WHICH 
MAY RESULT FROM THE USE OR POSSESSION OF THE INFORMATION; OR FOR ANY LOSS 
OF PROFIT, REVENUE, CONTRACTS OR SAVINGS, OR ANY OTHER DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF 
OR INABILITY TO USE THIS INFORMATION, ANY DEFECT IN THE INFORMATION, OR THE 
BREACH OF THESE TERMS OR CONDITIONS, WHETHER IN AN ACTION IN CONTRACT 
OR TORT OR BASED ON A WARRANTY, EVEN IF ALK OR ITS LICENSORS HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  Some States, Territories and Countries do 
not allow certain liability exclusions or damages limitations, so to that extent the above may not apply 
to you.

Export Control.  You agree not to export from anywhere any part of the Data provided to you or any 
direct product thereof except in compliance with, and with all licenses and approvals required under, 
applicable export laws, rules and regulations.

Entire Agreement.  These terms and conditions constitute the entire agreement between ALK (and its 
licensors, including their licensors and suppliers) and you pertaining to the subject matter hereof, and 
supersedes in their entirety any and all written or oral agreements previously existing between us with 
respect to such subject matter.

Governing Law.  The above terms and conditions shall be governed by the laws of the Netherlands, 
without giving effect to (i) its conflict of laws provisions, or (ii) the United Nations Convention for 
Contracts for the International Sale of Goods, which is explicitly excluded.  You agree to submit 
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to the jurisdiction of the Netherlands for any and all disputes, claims and actions arising from or in 
connection with the Data provided to you hereunder.

----------------------------------------------------------------------------------------
Software License Agreement for FONIX TEXT TO SPEECH ENGINE

IMPORTANT! READ THIS License AGREEMENT BEFORE OPENING THIS SOFTWARE 
PACKET.  BY OPENING THE SEALED PACKET OR USING THE SOFTWARE, YOU INDICATE 
YOUR ACCEPTANCE OF THE ENTIRE AGREEMENT.

SOFTWARE License AGREEMENT
This Agreement is a legal agreement between you and Fonix Corporation ("Fonix"), but may be 
superseded by a separate license agreement that you and Fonix have signed.  The software in this 
packet ("Software") and its media and documentation (collectively, the "Product") are protected by 
copyright and other intellectual property laws and international treaties.  You have no title to, or 
ownership of, the Product, other than its physical media.  Fonix reserves all rights not specifically 
granted in this Agreement.

USE AND RESTRICTIONS:  You may operate the Software on only one computer.  However, if you 
have purchased a network or multiple-user license, you may load and use as many single-use copies 
and/or support as many concurrent users, in the aggregate, as are authorized by such license.  You may 
make only one copy of the Software, retaining the Fonix CD or other media for storage and back-up 
purposes.  The Software does not include updates, maintenance, or support, which may be separately 
available.  This Software and its voice output are for your personal, individual use only.  You are 
not permitted to broadcast or distribute the voice output of the Software (i.e., synthesized speech) to 
more than one person or to use the Software's voice output for any commercial purposes.  You may 
not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network, or create derivative 
works based on any part of the Software.  You may not reverse engineer, decompile, or disassemble 
the Software.

LIMITED WARRANTY: Fonix warrants that the Product's physical media will be, under normal 
use, free from defects in material and workmanship for one year from the date you purchased it.  
Fonix's entire liability, and your exclusive remedy under this warranty, will be replacement of the 
defective media without charge.  EXCEPT FOR THIS LIMITED WARRANTY, FONIX MAKES NO 
WARRANTIES, EXPRESS OR IMPLIED, AND DISCLAIMS ANY IMPLIED WARRANTY OR 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Fonix does not warrant that 
the product is entirely error-free.  FONIX'S TOTAL LIABILITY FOR ANY CLAIM OR DAMAGE 
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE SHALL BE LIMITED 
TO DIRECT DAMAGES, WHICH SHALL NOT EXCEED THE License FEE YOU PAID.  IN NO 
EVENT SHALL FONIX BE LIABLE FOR LOST PROFITS, LOST DATA, INTERRUPTIONS OF 
BUSINESS, OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OF OR INABILITY TO USE THE SOFTWARE, REGARDLESS OF WHETHER FONIX HAS 
NOTICE OF THE POTENTIAL FOR SUCH LOSS OR DAMAGE.
The above limitations may be superseded by law in some jurisdictions.
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U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and any accompanying materials 
are provided with Restricted Rights.  Use, duplications, or disclosure by the Government is subject 
to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software-Restricted Rights at 48 CFR 52.227-19, as applicable.  Contractor/manufacturer is Fonix 
Corporation at 1225 Eagle Gate Tower, 60 East South Temple St., Salt Lake City, Utah 84111.

GENERAL: If any term of this Agreement is found void or unenforceable, all other terms shall remain 
in full force and effect.  This Agreement shall be governed by the internal laws of Utah.  If you breach 
any term of this Agreement, Fonix may terminate this license and you must return all copies of the 
Product to Fonix.

ALK® Technologies, Inc. License AGREEMENT
CoPilot | Pocket PC 6 with AUSTRALIAN DATA
LICENSES: 1 User

THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE USER (either an individual or an entity), 
AND ALK Technologies, Inc. ("ALK").  IF YOU DO NOT AGREE TO THE TERMS OF THIS 
License, DO NOT INSTALL THE SOFTWARE.  Promptly return the package and accompanying 
materials (including written materials and containers) to the dealer from which you obtained them for a 
full refund. 
INSTALLING THIS SOFTWARE INDICATES YOUR ACCEPTANCE OF THE TERMS OF THIS 
License.

1. Grant of License:

This ALK License Agreement ("License") is a single-user, non-exclusive, non-transferable license 
agreement and not an agreement for sale. ALK hereby licenses the on-line User Guide and CD-
ROM software identified above (collectively, "the Software") to you under the following terms and 
conditions.

The Software may not be loaded onto a network of any type.  You may use the Software on any 
compatible personal computer, provided you use it on only one computer at a time.  The Software 
is "in use" on a computer when it is loaded into the temporary memory (i.e., RAM) or installed into 
the permanent memory (e.g., hard disk, CD-ROM, or other storage device) of that computer.  If the 
Software is permanently installed on the hard disk or other storage device of a computer (other than a 
network server) and one person uses that computer more than 80 percent of the time it is in use, then 
that person may also use the Software on a portable or home computer.  You may make a single back-
up or archival copy of the Software for back-up purposes only.  You may not transfer this Software or 
assign this License Agreement to another party.

You are NOT permitted, during the term of this License Agreement and thereafter to:
• Use the Software on a network or file server.
•  Use or copy the Software or the accompanying documentation except as provided in this License 

Agreement.
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•  Alter, merge, modify, or adapt the Software or the accompanying documentation in any way 
including disassembling or decompiling this Software.

•  Loan, lease, sell, transfer, or sublicense the Software or the accompanying documentation.
•  Copy, loan, lease, sell, transfer, or sublicense any output of this Software (including but not 

limited to printed maps and driving itineraries); However, you may provide a limited number of 
printed copies (up to 10) of a single trip to family members or traveling companions.

•  You are not permitted to use the Software for motor-carrier tariff or routing purposes.
•  Electronic reproduction and transmission of output to remote locations are not permitted.

ALK retains all rights not expressly granted.  Nothing in this License Agreement constitutes a waiver 
of ALK's rights under the U.S. copyright laws or other applicable copyright laws or any other federal 
or state law.

2. Term:

This License is effective upon receipt by you of the Software and upon opening the package.  The 
License is effective until terminated.  You may terminate this License at any time by returning all 
copies of the Software, and any portions thereof, to ALK.  The License terminates automatically if you 
fail to comply with any of the terms of this License Agreement.  You agree upon such termination to 
return or destroy this CD-ROM and all other copies of the Software and certify in writing to ALK that 
you have done so.

3. Limited Warranty:

ALK warrants that all media on which the Software is furnished shall, for a period of 90 days from 
delivery (the "Warranty Period") be free, in normal use, from defects in material and workmanship.  
ALK will have no responsibility to replace any disc(s) that have been damaged by accident, abuse, or 
misapplication.

Customer Remedies: ALK's entire liability and your exclusive remedy shall be, at ALK's option, 
either (a) return of the price paid or (b) replacement of the media that does not meet ALK's Limited 
Warranty, and that is returned to ALK with a copy of your receipt.

Except as specifically provided above, ALK MAKES NO OTHER WARRANTY OR 
REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE 
OR DOCUMENTATION, INCLUDING ANY WARRANTY AS TO THE QUALITY, 
PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.  IN 
NO EVENT WILL ALK BE LIABLE FOR DIRECT DAMAGES IN EXCESS OF THE License FEE 
OR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, EVEN 
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO CASE SHALL ALK'S 
LIABILITY EXCEED THE AMOUNT OF THE License FEE.

While the information contained in the Software was believed to have been correct at the time of 
publication, ALK cannot guarantee its accuracy and shall not be subject to liability for any errors or 
omissions.  Information in the Software and its accompanying preprinted materials is subject to change 
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without notice and does not represent a commitment or endorsement on the part of ALK.  Routes and 
miles generated by the Software are not suitable for commercial truck use.

THE WARRANTY AND REMEDIES SET FORTH ABOVE ARE EXCLUSIVE AND IN LIEU OF 
ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED.  No ALK dealer, distributor, agent, 
or employee is authorized to make any modification or addition to this warranty.  Some jurisdictions 
do not allow the exclusion or limitation of implied warranties or limitation of liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you.

4. Licensee's Responsibility:

You assume all responsibility for, and ALK shall not be liable for, all action taken, decisions made, and 
advice given as a result of your use of the Software.

5. General:

The export or re-export of the Software may be restricted by the laws of the United States and other 
countries, and you shall not export this Software in violation of any such applicable laws.  This 
License Agreement is governed by the laws of the State of New Jersey.

-------------------------------------------------------------------------------------
Software License Agreement for FONIX TEXT TO SPEECH ENGINE

IMPORTANT! READ THIS License AGREEMENT BEFORE OPENING THIS SOFTWARE 
PACKET.  BY OPENING THE SEALED PACKET OR USING THE SOFTWARE, YOU INDICATE 
YOUR ACCEPTANCE OF THE ENTIRE AGREEMENT.

SOFTWARE License AGREEMENT
This Agreement is a legal agreement between you and Fonix Corporation ("Fonix"), but may be 
superseded by a separate license agreement that you and Fonix have signed.  The software in this 
packet ("Software") and its media and documentation (collectively, the "Product") are protected by 
copyright and other intellectual property laws and international treaties.  You have no title to, or 
ownership of, the Product, other than its physical media.  Fonix reserves all rights not specifically 
granted in this Agreement.

USE AND RESTRICTIONS: You may operate the Software on only one computer.  However, if you 
have purchased a network or multiple-user license, you may load and use as many single-use copies 
and/or support as many concurrent users, in the aggregate, as are authorized by such license.  You may 
make only one copy of the Software, retaining the Fonix CD or other media for storage and back-up 
purposes.  The Software does not include updates, maintenance, or support, which may be separately 
available.  This Software and its voice output are for your personal, individual use only.  You are 
not permitted to broadcast or distribute the voice output of the Software (i.e., synthesized speech) to 
more than one person or to use the Software's voice output for any commercial purposes.  You may 
not modify, adapt, translate, rent, lease, loan, resell for profit, distribute, network, or create derivative 
works based on any part of the Software.  You may not reverse engineer, decompile, or disassemble 
the Software.
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LIMITED WARRANTY: Fonix warrants that the Product's physical media will be, under normal 
use, free from defects in material and workmanship for one year from the date you purchased it.  
Fonix's entire liability, and your exclusive remedy under this warranty, will be replacement of the 
defective media without charge.  EXCEPT FOR THIS LIMITED WARRANTY, FONIX MAKES NO 
WARRANTIES, EXPRESS OR IMPLIED, AND DISCLAIMS ANY IMPLIED WARRANTY OR 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.  Fonix does not warrant that 
the product is entirely error-free.  FONIX'S TOTAL LIABILITY FOR ANY CLAIM OR DAMAGE 
ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE SHALL BE LIMITED 
TO DIRECT DAMAGES, WHICH SHALL NOT EXCEED THE License FEE YOU PAID.  IN NO 
EVENT SHALL FONIX BE LIABLE FOR LOST PROFITS, LOST DATA, INTERRUPTIONS OF 
BUSINESS, OR ANY INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OF OR INABILITY TO USE THE SOFTWARE, REGARDLESS OF WHETHER FONIX HAS 
NOTICE OF THE POTENTIAL FOR SUCH LOSS OR DAMAGE.  The above limitations may be 
superseded by law in some jurisdictions.

U.S. GOVERNMENT RESTRICTED RIGHTS: The Software and any accompanying materials 
are provided with Restricted Rights.  Use, duplications, or disclosure by the Government is subject 
to restrictions as set forth in subparagraph (c)(1)(ii) of The Rights in Technical Data and Computer 
Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) and (2) of the Commercial Computer 
Software-Restricted Rights at 48 CFR 52.227-19, as applicable.  Contractor/manufacturer is Fonix 
Corporation at 1225 Eagle Gate Tower, 60 East South Temple St., Salt Lake City, Utah 84111.

GENERAL: If any term of this Agreement is found void or unenforceable, all other terms shall remain 
in full force and effect.  This Agreement shall be governed by the internal laws of Utah.  If you breach 
any term of this Agreement, Fonix may terminate this license and you must return all copies of the 
Product to Fonix.

-----------------------------------------------------------------------------------
License AGREEMENT FOR WHEREIS™ DATA

1. GRANT OF License
Telstra Corporation Limited (ABN 33 051 775 556) ("Telstra") through its agent Sensis Pty Ltd (ABN 
30 007 423 912) ("Licensor") grants you a non-exclusive, non-transferable license to use the mapping 
data ("Whereis Data") contained in this CD-ROM on the following terms ("License").  The License 
commences when you click on the "I Agree" button at the end of these terms and continues until 
terminated in accordance with this agreement.

2. RIGHTS OF USE
You may only use the Whereis Data for your own personal use.  You may only install and use the 
Whereis Data on one device at any one time.  You must not copy, reverse engineer, adapt, modify, 
distribute, publish in any form or permit any other person to use or deal with the whole or any part of 
the Whereis Data.
You must use reasonable steps to prevent any unauthorised copying or use of the Whereis Data; and 
immediately notify the Licensor if you become aware of any unauthorised copying or use of the 
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Whereis Data by any person or of any other infringement of the Licensor's rights in relation to the 
Whereis Data. The contact details of the Licensor are as follows: Sensis Pty Ltd, 181-189 Victoria 
Parade, Collingwood, Victoria 3066, Australia.

3. PROPERTY AND OWNERSHIP
All intellectual property rights (including copyright and any trade marks used by the Licensor and 
Telstra) in and to the Whereis Data are the sole and exclusive property of, or a use under license by, 
the Licensor (or its licensors).  Except to the extent permitted by this License, you do not acquire any 
intellectual property rights in or to the Whereis Data.

4. EXCLUSION OF LIABILITY
To the extent permitted by law, the Licensor does not make any warranties of any kind, whether 
express or implied, including any implied warranty of merchantability or fitness of the Whereis Data 
for a particular purpose. Licensor's liability for breach of any condition or warranty implied by statute 
which cannot be excluded is (to the extent permitted by law) limited to, in the case of the supply of 
goods, the repair, replacement or re-supply of the goods or of equivalent goods or the payment of the 
cost of repairing or replacing the goods or of acquiring equivalent goods; and in the case of the supply 
of services, supplying the services again, or the payment of the cost of having the services supplied 
again, provided that there shall be no such limitation for breach of such a condition or warranty where 
the relevant law prohibits such limitation.

Subject to this clause 4, the Licensor, its employees, agents and contractors will not be liable (whether 
in contract, tort or otherwise) to you or any other person for any loss, costs, damage or injury of any 
kind whatsoever (including incidental or consequential loss) wholly or partly arising out of or in 
connection with the use of or inability to use the Whereis Data.

5. TERMINATION
The Licensor may terminate the License immediately if you are in breach of any provision of this 
agreement.  Your rights under this agreement cease immediately upon termination of the License 
and you must immediately cease using the Whereis Data; and at the Licensor's election, return to 
the Licensor at the details described in clause 2.5 or destroy all materials bearing or containing the 
Whereis Data and, if required by the Licensor, shall certify that the Whereis Data and all such copies 
have been returned or destroyed.  Termination of the License does not affect any rights or remedies 
which accrued prior to termination.

6. GENERAL
You may not assign or sub-license your rights under this License. This agreement constitutes the 
entire agreement between the parties. Any previous agreements, understandings and negotiations 
cease to have any effect. A provision of, or a right created under, this agreement may not be waived 
except in writing signed by the Licensor. This agreement is governed by the laws in force in the State 
of Victoria, Australia.  A reference to a person includes a reference to a firm, corporation or other 
corporate body.




